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Preface

GLR is an organization dedicated to lunar scientific studies of all types but particularly to
studies of lunar domes and lunar geology. Most GLR members are amateur astronomers or
amateur geologists and many have a background in science, mathematics and/or computer
studies.
During the past several years, a spectral working group within GLR has become
increasingly interested in lunar geologic studies using remote sensing
(http://rst.gsfc.nasa.gov/ ). Remote sensing of the moon involves acquiring spectra of the
lu nar sur face using a var iet y of instruments. As experience with spectra was gained by the
gr oup, a nu mb er of ar ticles dealing with lu nar spectr a have b een publis hed in Selenology
T oday and ot her jour nals. Exper ience was gained in bot h Ear th based r emot e s ens ing
using spectrographs or band interference filters at the telescope and in interpretation of
spectral band images taken by the lunar probes. In particular the group has worked with
data acquired by Clementine and Lunar Prospector (http://www.mapaplanet.org/explorer/
moon.html ), and most recently by Selene (https://www.soac.selene.isas.jaxa.jp/archive/ ).
Remote lunar sensing typically involves acquisition of lunar spectra at UV-VIS-NIR
wavelengths (Clementine and Selene) or using a gamma ray spectrometer (Lunar
Prospector) although many other wavelengths and techniques can be used. GLR has
become interested in a wide variety of spectral issues ranging from their acquisition and
calibration to their application in understanding the rock and mineral composition of the
lunar surface. A great deal of experience has been gained by GLR in these areas over the
years. Because of the perceived complexity of lunar spectral studies and the lack of
availability of good reference material written at a basic level, this exciting field remains
“terra incognita” to most amateur astronomers.
This Spectral Manual was written in an attempt to educate amateur astronomers in lunar
spectral studies and lunar geology and to make this field more accessible to them. The
emphasis is on the determination of the rock and mineral composition of the lunar surface
using spectral studies. This initial edition of the manual assumes that the reader has at least
a rather basic knowledge of mathematics, limited computer skills, and at least some very
basic familiarity with the moon and with current thinking about its composition.
Hopefully future editions will evolve which will make the manual even more readable by
those with little or no grounding in science or mathematics.
The Spectral Manual discusses the acquisition and calibration of spectral images,
generation and interpretation of pixel block spectra from spectral images, identification
and mapping of spectral parameters, enhancing the resolution of lunar prospector
elemental abundance data, and the creation of lunar petrographic maps. Hopefully this will
provide a lot of new information to amateur lunar enthusiasts having an interest in lunar
geology, and will ma ke it poss ible f or them t o explor e this exciting field.

Finally, I would like to thank Raffaello Lena (the founder of GLR) for his continued
efforts to make spectral studies an important component of the ongoing research activity of
GLR. This manual would not have been possible without his hard work, leadership and
dedication to the amateur astronomy community. Anyone who finds this manual useful and
discovers that suddenly new horizons in lunar research (previously lying only in shadow)
have become accessible... owes Raf a debt of gratitude.

Rick Evans, GLR member
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>1. History of Lunar Spectral Work

Although the existence of the lunar regolith was predicted by infrared
studies of the Moon in 1948, technological advancements produced
little progress in the interpretation of lunar spectra prior to the 1960s.
Lunar spectra were simply viewed as reflected solar spectra since no
differences in the number or wavelength of Fraunhofer absorption
bands was present. In 1968, John B. Adams wrote a landmark paper in
Science in which he described the spectral identification of various
lunar minerals containing iron by the presence of an absorption trough
near 1000 nm. This method, capable of identifying various lunar
pyroxenes and olivine, has been used successfully for many years.
The return of Apollo lunar samples in 1969 enabled laboratory analysis
of lunar minerals and provided a basis for better calibration of
telescope based spectroscopy. Technological advances in spectroscope
design, filter construction and the advent of CCD imaging have enabled
a rapid advance in lunar geologic studies. In particular, remote sensing
using individual interference filters or tunable filters has facilitated
imaging at discrete wavelengths of light and has greatly increased
spatial resolution in spectral studies of the lunar surface. Since the
1990s a number of sophisticated lunar probes such as Clementine,
Lunar Prospector, Galileo, Selene, Chandrayaan, and others have added
substantially to our understanding of lunar composition. Such probes
eliminate the problem of spectral absorption caused by the Earth’s
atmosphere which can make terrestrial telescopic imaging at ultraviolet
and infrared wavelengths difficult.
Today, amateur astronomers having a modest background in
mathematics and the physical sciences and equipment amounting to
little more than a computer and internet connection can make useful
contributions to our understanding of lunar geology using readily
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available spectral data and public domain software.

>2. Mineralogical properties and spectral data

The spectra presented in this section are available on the World Wide
Web site: http://speclab.cr.usgs.gov

Other spectral libraries include the mid-infrared work of Salisbury et
al., (1991). A recently available spectral library web site is the NASA
ASTER site (http://asterweb.jpl.nasa.gov), managed by Simon Hook,
Jet propulsion Laboratory.

Pyroxenes
Pyroxenes are the most abundant ferromagnesian silicate minerals on
the Earth and the Moon. Pyroxene compositions fall largely into the
subset of the ternary system MgSiO3 -CaSiO3-FeSiO3 below 50 mole%
CaSiO3 .
This ternary field is bounded by the compositions :
CaMgSi2O6 (diopside)- CaFeSi2O6 (hedenbergite)-MgSi2O6 (enstatite)-
FeSi2O6 (ferrosilite).
Clinopyroxenes have general formula (Ca,Mg,Fe)2Si2O6, with small
amounts of Al, Mn and Na substituting for other elements. The most
significant clinopyroxene endmember is diopside, CaMgSi2O6. Augite
is the intermediate member of the series. However, augite is not just an
intermediate, but is unique in that it contains percentages of sodium
and aluminum that are mostly lacking in diopside and hedenbergite.
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Orthopyroxenes have general formula :
(Mg,Fe,Ca)(Mg,Fe,Al)(Si,Al)2O6

but natural compositions are dominated by two major end member
components: enstatite, Mg2Si2O6, and ferrosilite, Fe2Si2O6.
Low-Ca pyroxene, which may be intermixed with plagioclase shows an
absorption band at 890-940 nm while high-Ca pyroxenes have an
absorption band toward higher wavelengths (950 nm to 1000 nm).



page 7

Plagioclase
Plagioclase (a feldspar) is widespread and common in a wide variety of
igneous rocks. A highly relevant solid solution is the mineral
plagioclase feldspar, the most common mineral in the lunar highlands
and in the Earth’s crust.
Plagioclase varies from the endmember albite, NaAlSi3O8 to the
endmember anorthite, CaAl2Si2O8.
Plagioclase feldspar is spectrally characterized by a continuous upward
slope from 415 to 900 nm and a broad absorption band at about 1200-
1400 nm.
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Olivine
The mineral olivine is a common constituent in basaltic rocks on Earth
and on the Moon and a minor constituent of the lunar highlands.
Olivine chemistry provides an effective illustration of solid solution
(Mg,Fe)2SiO4. Olivine has a composition between the Mg2SiO4

endmember, known as forsterite, and Fe2SiO4, known as fayalite.
Magnesium and Fe are both cations of similar ionic radius; thus, they
behave similarly in geochemical systems and freely substitute for one
another in olivine’s crystal lattice (and in other minerals as well). It is
common in mineralogy to refer to the composition of a mineral with
solid solution by the fraction of one of the endmembers. For instance,
pure Mg2SiO4 is 100% forsterite, or in common notation, Fo100, and
pure fayalite would be Fo0.
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Olivine has band centers comprised from 1005 to 1100 nm.
Note that pyroxenes absorb at both 1000 nm and 2000 nm but olivine
does not absorb at 2000 nm. Plagioclase feldspar shows a broad
absorption band at about 1200-1400 nm.
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Glass
The term glass refers to a material that solidifies from a molten state.
Glass is amorphous and lacks the internal structure that is characteristic
of minerals. On the Moon, glass occurs by two mechanisms. One is by
meteorite impact. The Moon experienced an early history of
cataclysmic bombardment. Another population of lunar glass is
composed of volcanic glass. Almost of this material is basaltic (Mg-
and Fe-rich), though the contents of other constituents like Titanium
vary considerably and result in differences in color (e.g. orange glasses
and black beads). The amorphous structure of volcanic glasses of
basaltic composition produces broad less well-defined absorption bands
centered near 1.0 and 2.0 μm.
Among the various glass types, orange glass can show ultraviolet
absorption but typically is associated with a fairly high titanium
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content. However if the Mg/Al ratio is < 1.0 the material would not
be consistent with a volcanic glass. Most volcanic glasses have Mg/Al
ratios in the range of 1.7 to 3.3.
Olivine and certain impact glasses/melts show a band center above 1.0
μm, but only olivine rich areas will be bright on a 2.0/1.5 μm ratio
image.

Rocks
A rock is a naturally occurring solid aggregate of consolidated
minerals, with or without glass. A rock may contain fragments of other
rocks. Igneous rocks are those that form from molten material
(magma). Igneous rocks are divided into plutonic and volcanic rocks.
Plutonic rocks form when magma is emplaced underground, cools
slowly, and crystallizes minerals coarse enough to identify with the
naked eye. Volcanic rocks are erupted onto the surface, cool relatively
quickly, and are composed of fine-grained minerals and glass. While a
large portion of the lunar regolith is composed of free mineral grains
and glass particles, there are many identifiable examples of original
lunar plutonic and volcanic rocks.

An illustration of the spectral parameters which denote the chemical
differences between specific rocks are shown in Table 1.
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Table 1

Rock Type Mineral Absorption
Band

Remarks

Basalt High-Ca pyroxene
(>50%)

0.95 - 1.00 mi-
crons

Basalt with
high olivine

High-Ca pyroxene, oli-
vine

(10-20%)

0.95 - 1.00 mi-
crons

Olivine broadens absorp-
tion band, moves to
slightly higher wave-
lengths

Anorthosite

Plagioclase feldspar,
little or no pyroxene

(<5%)
No pyroxene

absorption band

Norite Plagioclase feldspar,
low-Ca pyroxene

0.90 - 0.93 mi-
crons

Band strength varies with
pyroxene content. Pyrox-
ene has higher Ca content,
or rock contains compo-
nent of high-Ca mixed in
similar to basalts but have
lower abundance of py-
roxene.

Norite Plagioclase feldspar,
low-Ca pyroxene

0.93 - 0.95 mi-
crons

Gabbro High-Ca pyroxene 0.97 - 1.00 mi-
crons

Similar to Basalts, but
have lower abundance of
pyroxene

Gabbro High-Ca pyroxene with
low-Ca pyroxene

0.95 - 0.97 mi-
crons

Dunite Olivine 1.1 microns
Troctolite Feldspar with olivine 1.1 microns
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2.1 Primer on Lunar Geology
Ninety-Eight percent of the lunar crust (excluding glasses) is composed
of just four minerals: plagioclase feldspar, pyroxene, olivine and
ilmenite. The lunar crust appears to have arisen from a stratified global
magma ocean in which light weight felsic minerals (plagioclase
feldspar) floated on top of the heavier mafic minerals. After
solidification of the crust, basin forming impacts fractured the crust and
caused an outpouring of mafic basalts into what would become the
lunar maria. The lunar highlands were composed of 70-99%
plagioclase feldspar with by far the most common mineral being
Anorthosite (plagioclase feldspar). Crater impacts caused deeper crust
minerals to rebound to the surface at central peaks and crater rims.
Minerals present in these features often contain mixtures of plagioclase
feldspar and mafic components (Pieters and Englert, 1993; Tompkins,
1998). Examples include Noritic anorthosite, Anorthositic gabbro,
Troctolitic anorthosite, Norite, Gabbro, Troctolite, and Dunite. All of
these contain plagioclase feldspar but they are differentiated by their
mafic components. Norite contains orthopyroxene (low in calcium).
Gabbro contains clinopyroxene (higher in calcium). Troctolite contains
some olivine while dunite is composed primarily of olivine.
The lunar maria are composed of heavier and darker basalts rich in
such mafic components as pyroxenes (with clinopyroxene
predominating in the maria while orthopyroxene predominates in
highland mafic rocks), olivine and ilmenite (FeTiO3). Basalts can be
classified as low titanium, high titanium and iron rich. High titanium
basalts were deposited between 3.85 and 3.55 billion years ago while
low titanium basalts were deposited 3.45 to 3.15 billion years ago.
Constructional volcanic features formed during the later stages of
volcanism on the Moon, characterised by a decreasing rate of lava
extrusion and comparably low temperature of eruption, resulting in the
formation of effusive domes. Early stage lavas were very fluid due to
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their high temperatures, massive volumes, and mineralogy. Lunar lavas
are mafic in composition (low silica content, high metal oxide content)
and tend to have a low viscosity, as opposed to felsic lavas (high silica
content), from andesite to rhyolite in composition, which on Earth
produce steep-sided domes with short lava flows. Early works by
Baldwin (1963) and Fielder (1965) have drawn attention to the
similarities of lunar domes to terrestrial igneous and volcanic features.
The first lavas on the moon flowed from eruptive fissures and did not
produce volcanoes. Across time, the erupting lavas cooled, decreased in
flow rate, and began to crystallise so that they began to pile up around
the vent through which they effused, forming low shield-like
volcanoes. Lower effusion rates due to lower speed of lava uplift and
magmatic differentiation may have increased lava viscosity, eventually
leading to steeper flank slopes. At that stage, extrusion rates were
apparently relatively low, compared to the very high values
characteristic for flows associated with major lunar sinuous rilles and
terrestrial flood basalts, but may have been relatively high compared to
similar terrestrial shields. Many of the lunar effusive domes have a
central crater pit, which occurs upon magma withdrawal and
subsequent collapse into the vent.
The vast majority of domes are in the maria, as this is the place where
lunar lavas tracked up deep-seated faults created by the basin impacts.
However, a few occur in highland regions, as a variety of
'cryptomare' (lavas covered over by thin veneers of highland material)
do occur.

Mare domes differ from distinctive high-albedo domes of volcanic
origin located in or near the highlands. The classical examples of
highland domes are the Gruithuisen domes, which have a higher albedo
than the nearby Mare Imbrium and also larger diameters and steeper
slopes than mare domes. This refers to an early volcanism which was
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probably unrelated to the lunar maria and was also of different
mineralogy (Chevrel et al., 1999). The higher reflectance and spectrally
red appearance of these domes supports the assumption of a different
mineralogy, which is consistent with lava having a lower FeO and TiO2

content than mare basalts. It is suggested that the source of this lava is
the lower crust, differing from the mare source region, the upper
mantle.
Volcanic eruptions created lava flows, domes and pyroclastic deposits
on the Moon. More than 100 lunar pyroclastic deposits have been
recognized and classified as small and regional deposits on the basis of
size and morphology (Gaddis et al., 2003 and references therein).
Characterization of the nature of the lunar pyroclastic deposits (LPDs)
is essential for models of formation, segregation and emplacement of
lunar magmas. There are two styles of volcanism that might leave dark
mantling units on the Moon. Regional deposits are thought to have
been emplaced as products of continuous or Strombolian-style
eruptions, with wide dispersion of well-sorted pyroclasts (Gaddis et al,
2003 ). Intermittent or Vulcanian-style eruptions likely have produced
the small pyroclastic deposits, with explosive removal of a plug of lava
within a conduit and forming an endogenic vent (Head and Wilson,
1979; Weitz and Head, 1999). Thus the Strombolian eruptions may
have formed the largest dark mantle deposits on the Moon while the
Vulcanian eruptions feature short explosions of gas and rocks and tend
to be smaller than Strombolian eruptions. Because gases need to build
up near the vent, they do not involve large volumes of magma. Hence,
Vulcanian eruptions likely form the smaller patches of dark materials
on the moon, with a recognizable central pit or vent structure (Head
and Wilson, 1979). Among the largest of the dark mantle deposits are
Aristarchus plateau, Mare Humorum, South Mare Vaporum and
Sulpicius Gallus deposits. The explosive eruptions that formed the
lunar dark mantle deposits have been likened to some types of
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terrestrial volcanic activity. Intermittently explosive or Vulcanian-style
eruptions are likely to have produced the small pyroclastic deposits,
with explosive decompression acting to remove a plug of lava within a
conduit and to form an endogenic vent crater (Head and Wilson, 1979).
The small pyroclastic deposits have been further subdivided into three
compositional classes on the basis of their 1.0-micron or mafic
absorption bands in Earth-based spectra (e.g., Gaddis et al, 2003).
Mafic bands of small pyroclastic deposits in the Group 1 class are
centered near 0.93 to 0.95 microns, have depths of 4 to 5%, and are
asymmetrical. Their spectra resemble those of typical highlands and are
indicative of the presence of feldspar-bearing mafic assemblages which
are dominated by orthopyroxene (e.g . small pyroclastic deposits are
found on the floors of Atlas Crater). Mafic bands in spectra for Group
2 deposits are centered near 0.96 microns, have depths of ~7%, and are
symmetrical in shape. Group 2 spectra are similar to those of mature
mare deposits, and they are dominated by clinopyroxene (e.g . two
small deposits east of Aristoteles Crater ). Small pyroclastic deposits in
Group 2 appear to consist largely of fragmented plug rock material,
with insignificant amounts of highland and juvenile materials (e.g.,
Gaddis et al., 2003). Group 3 mafic bands are centered near 1.0 micron,
have depths of ~5 to 7%, are relatively broad and asymmetrical, and
are probably multiple bands. Spectra of Group 3 deposits are
dominated by olivine and orthopyroxene; Examples of Group 3 small
pyroclastic deposits are those of J. Herschel Crater (62°N, 42°W) and
the well known Alphonsus Crater.
On the other hand, in a Strombolian eruption explosive decompression
occurs as the pressure is released and the magma and gas rise in an
expanding column of erupting material. For the Moon the particles will
spread out over an area roughly six times larger on the Moon than they
would for a similar eruption on Earth. Larger fragments will be
deposited closest to the vent. A Strombolian eruption is consistent with
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the volatile coated spheres returned from the Apollo 17 landing site.
Among the largest of the dark mantle deposits are Aristarchus plateau,
Mare Humorum, South Mare Vaporum and Sulpicius Gallus deposits.
In composite ratio images based on 415, 750 and 1000 nm, the iron rich
basalts have a strong absorption signal at 1000 nm and appear greenish.
Low titanium basalts appear purplish blue while high titanium basalts
like ilmenite basalts appear lighter blue due to titanium absorption at
415 nm. Titanium rich areas of the mare appear more blue and titanium
poor areas appear more red in maturation ratio images. These mafic
components are mixed with plagioclase. They can be subtyped as being
rich or poor in calcium, titanium and aluminum. Ilmenite (FeTiO3)
contains iron but is rich in a titanium oxide. Older lunar features such
as the lunar highlands have been exposed to micrometeorite
bombardment for eons and have what is termed a “mature” surface soil
containing glasses. This mature soil produces the distinctive red
appearance on ratio images taken at 415, 750 and 1000 nm as described
above.
Dark mantling material (DMD) containing glasses can be recognized
using a different combined ratio images. The 750/415 nm ratio image is
assigned to the red channel. The 750/950 nm ratio image is assigned to
the green channel and the 750 nm ratio image is assigned to the blue
channel. Features that have a high 750/415 nm ratio are bright red in
color and indicate mature highland soil or glasses (impact or volcanic).
A high 750/950 nm ratio produces a green color and indicates the
presence of Fe-bearing material, which is referred as a mafic signature.
DMDs are low in albedo and therefore have low signal in the 750 nm
wavelength region which is represented by the blue channel. In the
combined ratio images the dark mantling material appears strongly
bright orange or reddish.
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>3. Preparation and Significance of Ratio Images
The Clementine probe took a series of lunar images between February
and May of 1994. Of the several cameras used, the UVVIS camera
provided image sets at 415, 750, 900, 950 and 1000 nm that are
particularly useful in the creation of false color and ratio images of
geologic significance.
Raw Clementine data is available from the National Space Science
Data Center (see http://nssdc.gsfc.nasa.gov/nssdc/obtaining_data.html)
in the form of a set of CD-ROM disks. The disks archive the raw
UVVIS images by lunar orbital revolution number, the imaging
wavelength and the lunar longitude and latitude of the feature imaged.
Images are stored in a compressed format and are converted to tif
format using a DOS utility program (clemdcmp.exe) which is provided.
Creation of false color images by assignment of a single wavelength to
a particular color channel can provide some useful geologic
information about the iron and titanium content of the surface (Flor et
al., 2003; Gillis et al., 2004; Giguere et al., 2000). Iron preferentially
absorbs at 1000 nm while titanium absorbs at 415 nm (Lucey et al.,
1998; Lucey et al,1995). However, it is usually more informative to
assign ratio images to color channels since this has the effect of
reducing the effects of albedo. These images are created by dividing an
image taken at one wavelength by a second co-registered image taken
at different wavelength. Assigning different ratio images to the red,
green and blue color channels of a single image produces a single
combined ratio image.
Combined ratio images created from an image set taken at 415, 750 and
1000 nm provides basic information on lunar surface maturation and
limited information about mafic composition (Tompkins et al., 2000);
Spudis et al., NASA publ). The 750/415 nm ratio image is assigned to
the red channel. The 750/1000 nm ratio image is assigned to the green
channel and the 415/750 nm ratio image is assigned to the blue
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channel. We will refer to this composite ratio image as a maturation
ratio image. When the RGB image is viewed, mature highland soils
appear red or orange due to the high glass content that results from
eons of micrometeorite bombardment. Surfaces low in titanium content
also have a reddish color and pyroclastic orange glass deposits have a
very deep red color (Gaddis et al., 2003). Freshly excavated lunar
features appear blue as do mare surfaces having a high titanium content
(ilmenite rich). Mafic components, typically rich in iron, absorb at
1000 nm and appear yellowish green (due to mixture of the reddish
orange of mature soil with the green characteristic of mafic absorption)
or deep indigo blue (titanium poor basalt). Mature mare soils appear
reddish or purplish while freshly exposed mare surfaces appear
yellowish. The basalts of the maria give the strongest signals, but
weaker mafic components in certain highland features can also give a
response. Yellow color signals often indicate freshly excavated basalt
features, especially when found in crater and rille walls. Bright blue
signals indicate a freshly exposed non-mafic terrain (i.e. such as freshly
exposed Anorthosite).
Combined image ratios created from 415, 900, 950 and 1000 nm
images provide additional information on surface mafic constituents.
The usual scheme is to assign 750/900 nm to the red channel, 750/1000
nm to the green channel and 750/950 to the blue channel (Tompkins et
al., 2000). We will refer to this ratio image scheme as a mafic ratio
image. Using this scheme low calcium pyroxenes (orthopyroxenes like
Norite or Noritic anorthosite) appear reddish, olivines (such as Olivine,
Dunite, Troctolitic anorthosite, and Troctolite) appear brighter green,
and high calcium pyroxenes (clinopyroxenes like Gabbro or
Anorthositic gabbro) appear bright blue. Anorthosite doesn’t absorb
and appears dim grayish green which can be compared geographically
to its blue appearance on ratio images taken at 415, 750 and 1000 nm
(see above). This response is useful in subtyping mare basalts and also
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for detecting and subtyping the weaker mafic constituents found in
pyroxene bearing plagioclase in the lunar highlands. In addition,
comparison of an albedo image with a single ratio image taken at
750/1000 nm can assist in differentiating anorthositic features from
other high albedo features such as recently formed craters and their
ejecta.

The Maturation Ratio Image
False color composites are created by copying each image to a
particular channel in a blank color photograph. Typical channel
assignments include 1) red=750 nm, green=1000 nm, blue=415 nm;
and 2) red=1000 nm green=900 nm, blue=415 nm. The channels are
then balanced for brightness and contrast.
Creation of composite ratio images is slightly more complex. The 750
nm image is divided by the 415 nm image using software designed for
this purpose. We use a Windows based freeware program, ImageJ (see
http://rsbweb.nih.gov/ij/). Similarly, the 750 nm image is divided by
the 1000 nm image and the 415 nm image is divided by the 750 nm
image. This process creates three separate ratio image files: 750/415
nm, 750/1000 nm and 415/750 nm. These files are then respectively
assigned to the red, green and blue channels of a blank color image.
The channels are then balanced for brightness and contrast.
The Mafic Ratio Image
Using the same techniques, a combined ratio image is created in which
the channel assignments are: red=750/900 nm, green=750/1000 nm and
blue=750/950 nm. Creative individuals can also try combining single
wavelength channel assignments with ratio image assignments. One
scheme of this nature that is sometimes used has the following channel
assignments: red=750 nm, green=950/750 nm, and blue=415/750 nm.
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I. Example: False Color and Ratio Image Study of Tycho
Central Peaks

Clementine spectral band images can be downloaded from the USGS
map a planet lunar website in 16 bit tiff unstretched format and opened
in ImageJ. ImageJ (http://rsbweb.nih.gov/ij/) allows arithmetic
functions to be performed between band images using the Process >
Image Calculator menu. Ratio images can be created by dividing one
band image by another in this way.

750 nm 750/1000 nm

The images are of good quality and are not over saturated by albedo
features. The 750/1000 nm image removes what little albedo problems
exist in the 750 nm image. The brighter areas on the 750/1000 nm
image have the potential to be mafic materials. The images show
enough promise to warrant further processing of the image set.

The next step involves the creation of two false color images. The first
was created by assigning 750, 1000, and 415 nm images to red, green
and blue color channels. The second was created by assigning 1000,
750 and 415 nm images to red, green and blue color channels.
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R=750 G=1000 B=415 R=1000 G=900 B=415

The images begin to reveal a high likelihood that the central peaks are
composed of mafic materials. The peaks are darker than the
surrounding crater floor and show subtle compositional variation.
Creation of a “maturation” and a “mafic” composite ratio image
proceeds as follows. The maturation image is created by assigning the
750/415, 750/1000, and 750/415 nm images to the red, green and blue
channels respectively. The mafic image is created by assigning
750/900, 750/1000, and 750/950 nm images to the red, green and blue
channels.

“Maturation” Ratio Image
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“Mafic” Ratio Image

The strong green coloration in the maturation image confirms the mafic
nature of the central peaks and adjacent crater wall. The floor of the
crater consists of mature regolith with a reticulated pattern of mafic
material spread on it. Although it has a strong mafic signature, the
mafic element composing the central peak is not olivine. If it were
present olivine would have a green signature on the mafic ratio image.
Rather, the mafic image coloration supports the mafic element being a
pyroxene. It is sometimes possible to differentiate high calcium from
low calcium pyroxenes. The color signature of the high calcium
pyroxenes (clinopyroxenes) is bluish green through bluish violet on a
mafic ratio image while the signature of a low calcium pyroxene
(orthopyroxene) is distinctly red. On that basis, it appears that the mafic
ratio image above would best support a high calcium pyroxene as the
principal mafic component. The leading mineral contender would be
clinopyroxene which is commonly found in gabbros but can also be
present as a minor component in mainly anorthositic rock, or be mixed
with other pyroxenes as well.
A single ratio image of 2000 nm/1500 nm has been shown to be very
useful in the discrimination between the pyroxenes and olivine. If the
feature in question is bright in this ratio image then the presence of
olivine is favored. This is because pyroxenes absorb at both 1000 nm
and 2000 nm but olivine does not absorb at 2000 nm (cf. section 2).
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2000/1500 ratio

Since the central peak area is quite dark in the 2000/1500 nm ratio
image, there is no indication of the presence of Olivine.

II. Example: False Color and Ratio Image Study of Reiner γ
To create a maturation image of the Reiner γ the 0.750/0.415 μm ratio
image is assigned to the red channel, the 0.750/1.000 μm ratio image is
assigned to the green channel and the 0.415/0.750 μm ratio image is
assigned to the blue channel. In the maturation image immature
surfaces appear greenish-blue while older mature soils appear reddish.
The yellow color indicates freshly excavated basalt features. Small
areas of swirl material to the north and south of the central region of
Reiner γ show the same spectral characteristic in a more subdued form.
The elliptical dark line inside the swirl appears composed of mature
soil that has been exposed to normal lunar weathering processes.
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Reiner γ  maturation image

III. Example: False Color and Ratio Image Study of Orientale
dark mantling material

Dark mantling material (DMD) containing glasses can be recognized
using a different combined ratio images. The 750/415 nm ratio image is
assigned to the red channel. The 750/950 nm ratio image is assigned to
the green channel and the 750 nm ratio image is assigned to the blue
channel.
The DMD anular ring shows an evident orange color, while the
surrounding highland terrain appears red. The hilly terrain and the
elongated vent show a green and a light blue color.
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>4. Introduction to Lunar Spectra
Lunar spectra can be obtained from probes orbiting the Moon or from
Earth based telescopes (professional or amateur instruments). In either
case they can be created from multiple filter images taken at different
discrete wavelengths or created as continuous spectra using a slit/
grating or objective prism spectroscope. This manual concerns itself
with UV-visible-NIR spectra in the range of about 415 nm (i.e. 0.415
micron) through about 2000 nm (2.0 micron). Spectra taken through
the Earth’s atmosphere will show reduced or absent sensitivity at UV
wavelengths and at certain NIR wavelengths due to atmospheric
absorption and these effects are worse at sea level. Lunar spectra are
typically calibrated against the geography of the Apollo 16 landing site
because numerous lunar samples from this area were returned to Earth
for spectral study. The sample most often used for calibration of spectra
is sample # 62231 and calibration data are available for directional
hemispheric reflectance (used to calibrate Earth based telescopes) and
bidirectional hemispheric reflectance (used to calibrate probe spectra).
Earth based telescopic spectra of a lunar feature can be normalized by
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dividing each discrete spectral band image (or a continuous spectral
band image from a spectrometer) by its corresponding image of the
Apollo 16 landing site taken at approximately the same date and time.
The normalized spectra are then calibrated by multiplying them by
spectra of lunar soil sample #62231 for corresponding wavelengths.
Clementine probe spectra have already been well calibrated for
wavelengths between 415 nm and 2000 nm and can be downloaded
from the USGS map a planet website at: http://www.mapaplanet.org/
explorer/moon.html
Band spectra are downloaded in 16 bit tiff format with no stretch
applied. Clementine spectra can be converted to absolute reflectance by
multiplying them by 0.000135.
Selene probe spectra have not yet been completely calibrated but the
general method used for Earth based telescopes can be employed (but
using bidirectional reflectance data).

>5. Working with Spectra
We made the spectra below of a basaltic area in the wall of Dionysius
crater using a 9.25 inch Schmidt Cassegrain telescope and two cameras
(VIS, and NIR) with a series of 50 band filters.
The spectra were obtained near sea level. The spectra were calibrated
by division by the Apollo 16 band images and multiplication by lunar
soil sample #62231 directional hemispheric reflectance for
corresponding wavelengths. Sample #62231 data can be obtained
from:
http://pds-geosciences.wustl.edu/missions/lunarspec/
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The trough near 1.0 micron is the characteristic iron absorption trough
whose parameters (band center, band depth, and FWHM width) are
useful in mineral characterization.
To better visualize this trough a continuum division is performed. To
do this, a line is taken connecting the 0.75 and 1.5 micron reflectances
on the reflectance vs wavelength curve.
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Reflectance values for points along the curve shown above are then
divided by the reflectance values of corresponding points along this
line. Additional interpolated points can be added to the feature curve
before or after continuum division using a cubic spline interpolation.
The best spline interpolation of this type is the Akima interpolation
(discussed later).
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Pyroxenes are common lunar minerals showing this absorption trough.
Low calcium pyroxenes (orthopyroxenes) such as norites have a band
center between about 0.89 and 0.94 microns. Higher calcium pyroxenes
(clinopyroxenes) such as gabbro have a band center between about 0.95
and 1.0 micron. Mixtures have band centers in between. Olivine and
certain impact glasses/melts show a band center above 1.0 micron, but
only olivine rich areas will be bright on a 2.0/1.5 micron ratio image.
In the image below, an individual Clementine spectral plot for the
marked region near Flamsteed P, an absorption band at 0.97 micron is
due to the presence of a clinopyroxene.
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As shown in the following figure, the surface west of Reiner γ is
characterized by a shallow pyroxene absorption at 0.950 μm and a
second deeper absorption at 1.096 μm which is due to an admixed
olivine component in the basaltic lavas.
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Band depth is usually (but not always) proportional to mafic character
(i.e. a greater concentration of iron bearing minerals). This relationship
is not necessarily valid in areas where lunar prospector GRS (gamma
ray spectrometer) elemental abundance maps for iron are anomalous
with regard to Clementine spectral iron estimates. Lunar areas with
less than about a 5 percent mafic content are not very mafic and can
range from nearly pure anorthosite (the primary constituent of the
primitive lunar crust) to impure anorthosite containing small amounts
of iron bearing minerals. Titanium rich areas (typically ilmenite rich
mare areas) may show an additional absorption at between 0.43 and
0.45 nm. So, basic inspection of the band center, depth and FWHM of
the absorption trough near 1.0 micron can give information about
mineral content. However, more definitive information requires
determination of elemental abundances for Fe, Mg, Ca, Al, Ti, and O.
One then uses the amount of each of these present in wt% to determine
lunar mineral content and/or rock composition.

>6. Clementine Five Band UVVIS Spectra
Tompkins and Pieters (1999) showed that the shape of Clementine five
band UVVIS Spectra (0.415 to 1.00 microns) correlates with the
mineral content of lunar features.
We have applied this type of analysis to the crater Brayley below.
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raffaello
Text Box
Figure reproduced from (Tompkins, 1997) with the kind permission of Dr. Stephanie Tompkins.  
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Note that the spectra are normalized to 1.0 relative reflectance at 0.75
microns. The five band UVVIS spectral shape indicates that much of
the crater is anorthosite type 2 (An2) but that the darker areas contain
anorthositic gabbro, likely from mixture with mare basalt
contamination.

>7. Alternate Calibrations of Clementine UVVIS+NIR Imagery
The Clementine NIR camera had some problems with thermal
instability that can affect the 1, 1.1 and 1.25 micron imagery in
particular and producing a greater error than is acceptable. This, and
also differences in slope between Clementine and Earth based telescope
results have led to the developemnt of alternate calibrations to the
standard USGS based calibration. These alternate calibrations,
however, are still based on Apollo 16 site and soil sample #62231. Two
alternate calibrations are listed here and consist of a series of gain and
offset values for each Clementine band image (i.e. the appropriate band
image is multiplied by the gain and then the offset is added to the
image). These are the Lucey calibration and a calibration developed by
GLR which makes use of spectral data from the 2.2 meter Mauna Kea
telescope available on the internet. Both calibrations were developed
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using a linear regression technique of Earth based telescopic vs
Clementine results for a number of lunar features. The GLR calibration
is termed a “Keck” calibration because the 2.2 meter telescope is now
affiliated with the Keck observatory. The gain and offset values in the
tables below are applicable to all lunar features and do not need to be
re-calculated on a case by case basis.

>8. FeO and TiO2 Estimation Using Clementine Band Images
There are two ways to estimate iron or titanium content. The first is to
use spectral parameters to directly estimate FeO and TiO2 content, but
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this method has the problem of some albedo sensitivity and some error
on this basis (especially for TiO2). Equations have been developed by
Lucey and LeMouelic (and others) to estimate FeO and TiO2 from
Clementine band images.

Here, for example is an FeO wt% map of Alphonsus crater based on
this approach where the thee pyroclastic rich deposit areas are seen to
be bright (i.e. have a high FeO content). The central peak of Alphonsus
is less mafic and more anorthositic and is the small dark focus in the
midst of the three pyroclastic areas.
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Another important concept is the OMAT (Optical Maturity) map in
which brighter pixels represent younger features and darker features
represent older features that have been long subjected to lunar
weathering processes. There are several possible equations for the
calculation of the OMAT map, but one of the more common variants is
listed below:

OMAT = sqrt [(R750 - 0.08)2 + (R950/R750 - 1.19) 2 ]

where R denotes the calibrated Clementine band image in absolute
reflectance (i.e. multiplied by 0.000135).
Another variant is to replace the 0.08 and 1.19 coefficients with 0.04
and 1.22. Still another variant developed by Wilcox in 2005 is:

OMAT = (R750 * 0.1813) – (R950/R750) * 0.9834

An OMAT map of Tycho crater is shown in the following figure.
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Octave code for producing an OMAT map using the Lucey 2000
equation:
OMAT = sqrt [(R750 - 0.08)2 + (R950/R750 - 1.19) 2 ] is shown below:

% creates an omat map from a 750 and 950 nm band image in the same
directory
d2=dlmread("750.txt");
e1=dlmread("950.txt");
e2 = (d2.*.000135 - .08).^2;
e3 = ((e1./d2) - 1.19).^2;
e = (e2 + e3).^0.5;
% save OMAT as matrix 013
filename = sprintf('matrix%03d.mat',13);
save(filename,'e')

Just as there are variant estimations for the OMAT, there are also
variant estimations for FeO and TiO2.

Estimations developed by Lucey in 2000 are listed below:
FeO = 17.427 ThetaFe – 7.565
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where ThetaFe = - atan2 [ ((R950/R750) – 1.19) / (R750 - 0.08) ]
and reflectances are in absolute reflectance as described above.

TiO2 = 3.708 ThetaTi
5.979

where ThetaTi = atan [ (R415/R750) – 0.42 / R750 ]
Before we suggest a better method for evaluating elemental abundances
(i.e. which is much less albedo sensitive), it is first necessary to define
an automated method of achieving maps of the basic spectral
parameters: band center, depth, FWHM and slope of the principal
absorption trough near 1.0 micron.

>9. Spectral Parameter Mapping in Octave
GLR has developed an Octave m file program, ClementineMaps.m,
which produces spectral maps of the basic spectral parameters: band
center, depth, FWHM and slope of the principal absorption trough near
1.0 micron. Octave can be downloaded from here:
http://www.gnu.org/software/octave/
The Octave m program codes are listed in Appendix 1.
The program requires to additional m files (akima.m and fwhm.m) to
function. These three m files and also the Clementine band images
from 0.75 to 1.5 micron must be present in the same directory for
ClementineMaps.m to function. Although these band images are
downloaded in 16 bit non-stretched tiff format from the map-a-planet
website, they must be converted to .txt format using ImageJ to work
using this Octave application. ImageJ (version 1.43r is suggested) can
be downloaded from: http://rsbweb.nih.gov/ij/. Typically an earlier
version is downloaded and then upgraded as per the instructions.
Knowledge of the basic operation of this program is needed for many
lunar spectral activities undertaken by GLR. Basically, in this case the
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tif images are opened and saved as text images.

Running ClementineMaps.m
The progam is run in Octave from the directory in which it, akima.m,
fwhm.m and all Clementine band maps in txt format are located. The
band maps must be named as follows: 750.txt, 900.txt, 950.txt,
1000.txt, 1100.txt, 1250.txt and 1500.txt. Akima.m is used to create a
cubic spline interpolation used by ClementineMaps.m and fwhm.m is
used to create the full width at half maximum value for each map pixel.
To run ClementineMaps.m, simply type ClementineMaps from the
prompt, provided that this is done from within the correct directory in
which all of the above files are located. A basic knowledge of Octave
is essential to GLR activity in spectral work.
Running the program successfully produces three spectral parameter
maps within the same directory as the other files discussed above.
Program run time depends on the image size and is about 2 hours for
small images and about 24 hours for large images. These are
bandcenter, banddepth, and fwhm. Each of these files is in a text format
with header information. To remove the header information each of
these files is opened in Open Office Calc (or Excel 2007) and the files
re-saved as CSV files (Open Office Calc) or MS-DOS txt files (Excel
2007). In Open Office Calc, the files will then have a .csv extension.
Either file type can then be opened in ImageJ and saved as nearly any
desired file type, which for input into other GLR Octave programs is
a .txt format. To open bandcenter, banddepth, or fwhm in Open Office
Calc, use the Insert > sheet from file selection. A basic working
knowledge of Open Office Calc and/or Excel 2007 is basic to GLR
spectral work. For use in other GLR Octave programs such as
applycoeff.m, it is necessary to convert bandcenter.csv, banddepth.csv
and fwhm.csv to .txt format using ImageJ version 1.43r or later.
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Spectral maps produced for Bullialdus central peak area are shown
below. They have been converted to jpg format and a calibration bar
inserted using ImageJ.

Examination of spectral maps prepared using the Clementine
UVVIS+NIR dataset reveals that the region of Flamsteed is composed
almost exclusively of clinopyroxene bearing rock with a band center
near 0.970 μm, a band depth of 0.08 and a FWHM width of 0.18 μm.
There is some indication of the presence of orthopyroxene and olivine
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on the wall of the ruined ring formation known as Flamsteed P. The
olivine signature rather than impact melt is identified by the olivine
band center and depth maps and is confirmed by the 2.00/1.50 ratio
which shows the same regions as being bright.

The segregated maps corresponding for orthopyroxene band center
(0.890 to 0.945 μm), clinopyroxene band center (0.950 to 1.000 μm),
and olivine band centers (1.005 to 1.095 μm), are used to derive a false
color map where the red channel is assigned to orthopyroxene, green
channel to olivine and blue channel to clinopyroxene. This lunar region
appears as homogenous soil indicating the presence of high-Ca
clinopyroxene. In contrast, the wall of Flamsteed P shows the presence
of an admixed quantity of orthopyroxene and olivine.
No significant differences are detectable in the maturation image of the
examined region suggesting a high soil maturity.

To create a maturation image the 0.750/0.415 μm ratio image is
assigned to the red channel, the 0.750/1.000 μm ratio image is
assigned to the green channel and the 0.415/0.750 μm ratio image is
assigned to the blue channel. In the maturation image immature
surfaces appear greenish-blue while older mature soils appear reddish,
the yellow color indicates freshly excavated basalt.
The process of surface maturation causes a reddening of the surface
spectra (increase of a positive slope) and a decrease of the spectral
contrast of the absorption bands.
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The spectrum of the Flamsteed P wall shows an An2 signature using
representative spectra for highland rocks (cf. section 6) taken by
Tompkins and Pieters (1999). Moreover the continuum-removed
reflectance spectrum shows a single absorption minimum and a broad
olivine-related inflection feature. Plagioclase feldspar is spectrally
characterized by a continuous upward slope from 415 to 900 nm and an
absorption band at about 1300-1400 nm. Low-Ca pyroxene, which may
be intermixed with plagioclase shows an absorption band at 940 nm.
Hence, the spectral data indicate the presence of the plagioclase
feldspar containing up mafic minerals composed of a mixture of
orthopyroxene and olivine.
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Working with very large Clementine UVVIS+NIR data files

Sometimes higher resolution studies of larger areas the size of the SPA
basin or Mare Crisium require working with very large data files. A
single band image in 16 bit tiff format might be as large as 7 Mb.
Octave is too slow to analyze files sets of this size in a timely way and
insufficient memory errors are also likely. When run for prolonged
periods computers tend to develop secondary problematic issues with
periodic automatic software updates, security checks, system
hibernation etc. interferring with program completion and causing
pro gra m “ lock- ups." Images larger than 1500 x 1200 may cause issues.
One way to avoid such problems and still work with large high
resolution band image downloads is to slice the original band images
into smaller subimage tiles in an automated fashion. We use the free
program ImageMagick (an older version such as 6.5.7-Q16 is fine, but
the version must be capable of working with 16 bit images). Use band
images in 16 bit tif format.
Then, as an example for the 750 nm band image of size 3000 x 1600
pixels, at the command prompt for ImageMagick we use a command line
such as:

> convert 750.tif –crop 600x400@ 750a.tif

The subimage block size here is selected is 600 x 400 pixels, but this
can be varied as necessary. It is helpful for the original image to first
be cropped to exact multiples of the desired width and height of the
subimage block desired (this eliminates blocks of different sizes being
created. When run on the original image described above, the result is
a group of 20 sequential band subimages of size 600 x 400 pixels. The
resulting image is opened using the File>Open command in ImageJ.
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The resulting displayed image will have a slider at the bottom and it is
possible to scroll through the 20 block images using it. Save the image
as an image sequence in ImageJ using File>Save As>Image Sequence
and choose txt format.
Maps can be made in Octave from each subimage and then the maps
can be rejoined into a single high resolution map. This can be done in
Photoshop manually, or a command at the ImageMagick prompt along
the lines of that shown below can be used:

>montage –mode Concatenate –tile 5x4 750a_*.tif 750a_rejoined.tif
This will produce a single image from all subimage blocks. The
specification –tile 5 x 4 indicates that the subimage block set is to be
assembled into a 5 x 4 matrix to reconstitute the original image
di me ns io ns. Image>Stacks>Make montage in ImageJ is an alternative for

32 bit  tif or  txt images. This option  requires that  the block  images be

imported as an image sequence (i.e. stack) in imageJ.

> 10. Production of Elemental Abundance Maps in Octave
Elemental abundance maps for Fe, Mg, Ca, Al, Ti, and O are easily
produced from a data set of the three spectral parameter maps described
above plus a map of the slope as given by the 0.75 micron Clementine
band image subtracted from the 1.5 micron Clementine band image for
the lunar feature of interest.
GLR has developed an automated Octave m file program,
applycoeff.m, for this purpose. The Octave code is listed in Appendix
1. It requires input files within the same directory as applycoeff.m
which are: bandcenter.txt, banddepth.txt, fwhm.txt, 750.txt and
1500.txt. The program automatically produces the slope map from the
750.txt and 1500.txt files. Other required files in the same directory are
the matrix files: matrix001, matrix003, matrix005, matrix007,
matrix009 and matrix0011. These matrix files contain needed
coefficients produced from a matrix regression of the spectral
parameter maps and slope map on the lunar prospector elemental
abundance map for each element for the global Moon. This has the
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effect of greatly increasing the spatial resolution of lunar prospector
elemental abundance data while producing a somewhat albedo resistant
result. The theory for this is somewhat complicated and involves matrix
algebra. It is beyond the scope of this manual, except to say that the
matrix regression is based on Ax=b where b is the lunar prospector
elemental abundance map, x is the comparison matrix created from the
band center, band depth, fwhm, and slope maps, and A is the coefficient
matrix for the element of interest (given the name matrix001 etc. as
described above).
Running applycoeff.m in Octave with the files described above present
in the same directory, produces an output of 6 matrix files: matrix002,
matrix004, matrix006, matrix008, matrix010, and matrix012 which
represent the elemental abundance maps for Fe, Mg, Ca, Ti, Al and O
in that order.

These files are opened and saved using the same method as described
above for the Octave produced maps bandcenter, banddepth and fwhm.

Required Coefficient Matrices
The required input coefficient matrices used by applycoeff.m are
produced by another GLR Octave program, newmatreg.m, which
creates them from input Clementine global lunar band images from
0.75 to 1.5 micron. The resulting matrix files: matrix001, matrix003,
matrix005, matrix007, matrix009 and matrix011 represent the
coefficients needed by applycoeff.m to calculate the elemental
abundances for Fe, Mg, Ca, Ti, Al and O respectively.

These matrices can be made availalbe to GLR members working in this
area. This set of coefficient matrices is applicable to all lunar feature
locations studied using applycoeff.m
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Example of Elemental Abundance Mapping
The elemental abundance maps for Stevinus below were produced
using applycoeff.m

The elemental abundance maps for Flamsteed P region in the following
figure were produced using applycoeff.m
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Mineral Determinations
Note that the color map shown above for Stevinus crater is labelled
gabbronorite. The gabbronorite composition is defined by certain
aluminum, magnesium and iron elemental abundance ranges listed at
the bottom right of the graphic. Using an analogous method, it is
possible to produce mineral maps for FAN (ferroan anorthositic norite),
norite, dunite, gabbronorite, troctolite, mare basalt, KREEP basalt,
aluminous basalt, anorthosite, etc.

GLR has Octave m file programs to produce maps of each of these
mineral types and can be made available to GLR members working in
this area. The specific ranges are subject to vary according to the
literature etc. These m files output maps of the pertinent elements but
with range restrictions imposed (any other pixels being set to zero).
These maps can then be placed in the RGB channels of a color image
to create a false color map for the topographic location of the mineral
under study. One such m program pair (read_from_ternary_diagram.m
and applycoeff_v2.m ) is based on three endmember (i.e. pure
minerals) elemental abundances and is found at the end of Appendix 1.

Magnesium wt% Aluminum wt% Iron wt%
Ferroan anorthosite (FAN) 0 to 1.5 17 to 19 1 to 3

Troctolite 10 to 19 9 to 16 4 to 6
Mare basalt 4 to 8 4 to 7.5 12 to 25

Anorthositic norite 4 to 9 17 to 25 2 to 5
Norite 4 to 9 17 to 25 5 to 25

Gabbronorite 2 to 16 4 to 9 8 to 25
KREEP 2 to 4.5 8 to 10 8 to 9.5

Aluminous Basalt 4.2 to 7.2 >6.8 9.3 to 14.0
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These two m files function together to produce a petrographic map. The
resulting petrographic map is saved as a 24-bit colour TIFF file named
"petrographic_map.tif", in which the red, green, and blue channel
represents the mare basalt, Mg-rich rock, and FAN endmember,
respectively. The sum of the channels is always 255, as the endmember
abundances always must sum up to 1. Both m files must be in the same
directory as the input image files and matrix files.
A petrographic map of Reine γ made according to the above description
is presented below. For Reiner γ, we have mostly mare basalt, some
Mg-rich rock, and nearly no FAN; that's why the petrographic map
looks red-orange.

A petrographic map for Stevinus crater is shown below and here the
presence of a greater concentration of magnesium rich rock, likely
GNTA (i.e. gabbroic noritic troctolitic anorthosite) is shown in green
and a fair amount of FAN (ferroan anorthosite) is shown in blue.
Gabbroic rock relatively rich in clinopyroxenes is shown in red.
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The petrographic map of Tycho below shows clinopyroxene containing
gabbro to anorthositic gabbro in red, magnesium suite rock in green,
and ferroan anorthositic rock in blue.

A petrographic map of Flamsteed P region made according to the above
description is presented in the following figure. We determined the
petrographic which indicates the relative fractions of the three
endmembers mare basalt (red channel), Mg-rich rock (green channel),
and ferroan anorthosite (FAN, blue channel). Accordingly we have
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mostly mare basalt with some Mg-rich rock (the petrographic map
looks orange). Furthermore the map shows the presence of
magnesium suite rock (in green) in the wall of Flamsteed crater.

Petrographic maps of the Hyginus rille and of Alphonsus are shown
below as further examples of the districution of mare basalt,
magnesium suite rock, and ferroan anorthosite. The map of the Hyginus
rille shows mare basalt containing some olivine present along the rille
structure. The adjacent terrain shows ferroan anosthosite mixed with
mare basalt.

Hyginus Rille, petrographic map
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Alphonsus, petrographic map

The petrographic map of Alphonsus shows basaltic matrial associated
with the several volcanic vents present. The central peak is rather
anorthositic as is much of the surrounding terrain until one reaches the
basalt rich area to the west of the crater. Several small superficial
craters may have penetrated down through the rather anorthositic
surface into magnesian suite material.

Detection of Variations in Basalt Composition:
In addition to the standard petrographic maps described above, it is
sometimes useful to map the distribution of basalts having slightly
different compositions. Many different approaches can be taken, but
one that is in current use by GLR is a basalt mapping in which average
abundances of titanium and aluminum are used to differentiate different
basalt types. For example, the following abundances can be assigned
to the RGB channels of a false color image:

Red: Ti 1.6 wt% Al 9.25 wt%
Green: Ti 0.5 wt% Al 14 wt%
Blue: Ti 3.6 wt% Al 6.3 wt%
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Typical mare basalts appear in the red channel, aluminous basalts and
highlands type terrain appear in the green channel, and relatively higher
titanium basalts appear in the blue channel. An application of this
mapping technique to Mare Crisium is shown below. Highlands terrain
has been masked.

The surface of mare crisium and the southern portion of Mare Anguis
have a basalt composition with a low titanium and hi aluminum
content. Reddish areas have higher titanium and lower aluminum
content and represent older exposed subsurface basalts.
The Octave algorithm used to produce this mapping is applycoeff_v3a
and it’s code is presented in the Appendix. Variations on this mapping
theme can be tried using different elements and/or different wt %
abundances by changing the parameters in this program code.
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>11. Working with Selene Imagery

Calibration of Selene Multispectral Imager (MI) band images has
currently reached level 2B2. This level of calibration basically includes
radiometric calibration and conversion of output to radiance. In the
future, 2C calibration will eventually become available and will include
photometric calibration with conversion of output to reflectance and
also a systematic geocorrection of image bands. However, even at the
present stage of calibration, it is possible to use Selene data in a limited
way to generate spectra of lunar features and to generate spectral maps.
The purpose of Part I of this paper is to explain how to acquire Selene
multispectral imager VIS and NIR band data and to further enhance its
calibration for the purpose of generating relative reflectance spectra
and producing maps of spectral features.

Part I: Selecting, Downloading, Converting and Saving Selene
Archive IM Images

The Selene Multispectral Imager Dataset: General Description
The Selene (Kaguya) lunar probe acquired multispectral images at VIS
and NIR wavelengths between September 2007 and June 2009. Five
VIS bands were obtained at 0.415, 0.75. 0.9, 0.95, and 1.0 microns.
Four NIR bands were obtained at 1.0, 1.05, 1.25, and 1.55 microns.
The resolution of VIS bands is 20 meters/pixel. The resolution of NIR
bands is 62 meters/pixel. These images have not yet been assembled
into a fully calibrated mosaic as is the case for Clementine data, but
they are available for download from the Selene Data Archive as single
tile data. VIS five band images are packaged together in 16 bit
unsigned data with Little Endian byte order with a variable length data
header preceding the first image. There are no bytes between images
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and the images are co-aligned. NIR four band images are packaged
together in the same way. VIS and NIR images may or may not be
offset from each other and it may well be necessary for the user to co-
align VIS images with NIR images. VIS images are typically about 962
x 959 pixels although there is variation here. NIR images are typically
about 320 x 319 pixels. Once the VIS images are re-scaled to the
dimensions of NIR images, subpixel co-alignment (i.e. co-registration)
may require more than applying a simple (x,y) pixel offset.
Finding a Lunar Feature in the Selene Archive and Downloading VIS
and NIR data:
The first step here is to create an individual free account on the Selene
Data Archive website at: https://www.soac.selene.isas.jaxa.jp/archive/
which will enable access to the various Selene data products. Once
logged into the data search system, it is necessary to specify the desired
product. For the currently available Multispectral Imager data the
product name is LISM 2B2. Pressing the “Determination” icon selects
the listed product. Next, the time and date of the desired data is
entered, but in practice it is enough to simply list the start date of
September 14, 2007. The desired lunar feature is selected using the
Observation Range menu, by simply pressing the Setup Observation
Range icon. This will lead to the generation of a lunar map. The user
simply draws a box around the target area of interest and zooms the
image. A fairly high zoom level is usually desirable. Individual Selene
VIS and NIR data tiles are not much larger than the area covered by
Copernicus Peak 3. The icon labelled “Determination of Selection
Range” is pressed to send the longitude and latitude coordinates of the
area of interest to the main search page. All necessary constraints have
now been chosen and the “Search Execution” icon can be pressed to
access the available band data.
Available data tiles will be listed but it will be necessary to select VIS
or NIR image groups separately. Thumbnails of the feature can be
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viewed to aid in the selection of VIS and NIR image packages. Care
should be taken to choose VIS and NIR image packages that show
exactly or at least nearly the same geography (some offset may be
present between the image groups). Desired packages are added to an
order list which is then confirmed by the user. NIR and VIS files are
chosen separately. The Selene archive will send a confirmation of the
order and in a second email will specify a download address.

Working with Downloaded Selene Archive VIS and NIR Data
Packages
Downloaded VIS and NIR packages will be in .sl2 format. Windows
users should convert the file extension to a .tar extension. This will
allow unzipping each package using common programs such as
WinZip. Several files are present within each package, but the
important file is actually a zipped file with the extension .igz. It is
necessary to change this extension to a .gz extension which then allows
it to be opened with WinZip, gzip etc. When this file is unzipped, the
most important resulting file has an .img extension. This file contains
the archived image bands and a preceeding header with lots of image
data. The file is in an unusual .pds type image format which most
programs cannot read. We generally make a copy of the .img file and
give it the extension .pds for reasons that are explained below.

Using ImageJ to Open the .img file
ImageJ is a free image processing program. It is available for download
at: http://rsbweb.nih.gov/ij/download.html but to use it to work with
Selene .img files it is necessary to download an additional free plugin
called the Raw File Opener which is found under the Input/Output
section here: http://rsbweb.nih.gov/ij/plugins/index.html
Simple instructions for installing the plugin are present on at the
download site: http://rsbweb.nih.gov/ij/plugins/raw-file-opener.html
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When it is installed and working, the Raw File Opener is selected from
within the ImageJ menu: Plugins > Input-Output > Raw File Opener.

Reading Image Header Information
Using File > Open in ImageJ, the copy of the .img file that was
renamed to a .pds extension can be viewed, but only the header
information will be legible. However, reading the header information
will give some key pieces of information needed to unpack the images
in the VIS and NIR .img files. Files will always be in 16 bit unsigned
format with Little Endian byte order and zero bytes between images.
VIS .img files will contain five image bands and NIR .img files will
contain four image bands. But header information will give the image
width and height and the number of header bytes present before the
first image. These should all be recorded.

Opening the .img image package for VIS and NIR
VIS and NIR .img files are opened in ImageJ using the Raw File
Opener plugin: Plugins > Input-Output > Raw File Opener.
Information present in the header information must be entered and is
different for VIS and NIR .img files. Image dimensions can vary
slightly for different geographical areas imaged as well. For the most
part, NIR files are about 320 x 319 pixels and VIS files are roughly 962
x 959 pixels.
When an image is opened successfully it will open in an image
sequence viewing box with four bands for NIR and five bands for VIS
which can be viewed by moving a slider at the bottom of the image
sequence viewing box in ImageJ. Each image should have the
appearance of the thumbnail image included in .jpg format in each
download. If the images are distorted or skewed then most likely small
variations will be needed to adjust the image dimensions. Sometimes
very small adjustments to the dimensions given in the header are
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needed.
Each image should be saved as a 32 bit tiff image Image > Type >32 bit
and the VIS images should be re-scaled to the dimensions of the NIR
images. When this is done, the VIS+NIR images can be opened as a
single image sequence in ImageJ (see below). The nine VIS+NIR
image bands should be saved to their own directory. The name of each
tif image should be changed to its band wavelength keeping the tif
extension. Use 1000.tif for the VIS 1000 nm band and 1000a.tif for the
NIR 1000 nm band image. When Import > Image Sequence is selected
in ImageJ, clicking on the first band image will allow the entire group
to be imported.

Saving the VIS and NIR images in 32 bit tif format
When the VIS and NIR images are opened, they are best changed to 32
bit tiff type if this was not done previously. This is achieved as follows:
Image > Type >32 bit and their image groups are saved as separate
image sequences as follows: File > Save As > ImageSequence > tif.
Each individual image within the VIS and NIR groups are thereby
saved as individual tif images in 32 bit format. If necessary, the
brightness and contrast of the images can be altered without changing
the pixel values as follows: Image > Adjust > Brightness and Contrast.
The images should be re-named according to their band wavelength
and saved in 32 bit tiff format. It is convenient to name the 1000 nm
VIS image as 1000.tif and the 1000 nm NIR image as 1000a.tif.

Co-Alignment of VIS+NIR band images
If when viewing the image sequence of all VIS+NIR band images, it is
obvious that the two groups of images are offset from each other, then
it will be necessary to co-align them to subpixel accuracy. This must
be done using software capable of working with 32 bit images. We
generally open the NIR and VIS bands as two separate image groups in
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ImageJ and place them side by side. We crop each set to make them as
identical topographically as possible and resize the VIS image
sequence to the same dimensions as the NIR image sequence. Any
ragged edge artifacts need to be cropped out. After this is done, the
VIS+NIR image stack is then image stabilized using the image
stabilizer plugin for ImageJ. If alignment still isn’t good (which is
rare), sometimes use the commercial program MiraPro 7 to do a
multipoint alignment and then repeat the image stabilization.
Instructions for the co-alignment process using this software package
are beyond the scope of this paper, but are included in the manual for
MiraPro 7.

Part II: Generating Spectra and Spectral Maps using Selene
IM images

Image Re-Calibration

Method 1: Using Apollo 16 site and Apollo 16 Soil Sample
62231

The VIS + NIR band images as a 9 image group are loaded into
ImageJ as an ImageSequence. This is facilitated by putting only these
9 images into their own directory and when opening the Image
Sequence, only the first tif file is selected. All of the images will
automatically be opened in the image sequence in order of increasing
band wavelength.
There are two different approaches to image calibration each with its
good and bad points. One method is to select the Apollo 16 landing
site as the first set of VIS and NIR images downloaded from the Selene
Archive.
The VIS + NIR band images as a 9 image group are loaded into ImageJ
as an ImageSequence. This is facilitated by putting only these 9 images
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into their own directory and when opening the Image Sequence, only
the first tif file is selected. All of the images will automatically be
opened in the image sequence in order of increasing band wavelength.

Step 1: Image Normalization for Apollo 16 Site Band Images
With the Image Sequence opened, an area of medium albedo within the
Apollo 16 site is selected using the “box” icon on the ImageJ menu. It
should be on the order of 1000 or so pixels in size. As the slider is
moved at the bottom of the viewer, the next band image will appear,
but the boxed area remains in the same position. Pressing Control-H
will bring up the histogram data window and the average pixel DN
value can be read. It should be recorded for each of the nine band
images. The box is then removed by clicking anywhere on the selected
image.
Each band image is mathematically divided by the recorded histogram
average pixel DN value recorded for the boxed area as described
above. This is done in ImageJ by:
Process > Math > Divide. When the division is made ImageJ asks if
the division is to be applied to the currently selected image or to all
images. It should be applied only to the currently selected image. The
next image is then selected and divided by its boxed histogram value,
and the next, and so on until all nine images have been “normalized”.

If after the normalization process is completed, all of the band images
do not have quite nearly the same DN value for a selected large pixel
block area, then most likely the Apollo 16 site is not a good calibration
site for the data set under study. When this is the case, it is usually the
0.415 or the 0.749 micron bands that will appear brighter than the other
bands after normalization, indicating a bad calibration result is likely to
occur. When this happens, we usually abandon Method 1 and try to
move on to Method 2. However, if the the problem is only with the
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0.415 micron band then this band is not essential to determination of
the trough parameters close to 1 micron and Method 1 can still be used
for this work. It is essential, however, that the 0.749 micron band be
well normalized.

Step 2: Image Re-Calibration for Apollo 16 Band Site Images

The file RELABBDR.TAB is downloaded from the PDS Geosciences
Node found here:
http://pds-geosciences.wustl.edu/missions/lunarspec/

This file is opened in Excel or a similar spreadsheet program. The file
contains calibration correction gain coefficients based on Apollo 16 soil
sample #62231 converted to bidirectional reflectance (bidirectional
reflectance is used to correct lunar probe data while hemispheric
reflectance is used to correct Earth based telescope data).
The calibration factor for each Selene VIS and NIR band should be
recorded from the relabbdr.tab file. Interpolation is necessary for many
of the bands. Using ImageJ, each previously normalized Apollo 16
Selene band image is multiplied by its corresponding correction factor.
The image sequence is then saved as a series of 32 bit tif images. Feel
free to adjust the brightness and contrast of 32 bit tiff images as this
does not affect their pixel values.
The Selene VIS and NIR band images of the Apollo 16 site has now
been completed and can be used for calibration of Selene data for other
lunar features. The calibrated Apollo 16 site images should be viewed
as an image sequence in Image J and the average DN balue of the
Apollo 16 site determined for each band image using the histogram
function. The values should be recorded for each band.
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Step 3: Calibration of other lunar features against the Selene
Apollo 16 site.

Normalization:
A second set of Selene images is downloaded for the lunar feature of
interest. The target images are normalized by dividing each band image
by the histogram value of the un-normalized and uncalibrated (except
for the 2B2 pre-calibration already present in downloaded Selene
imaging spectrometer images) Apollo 16 site image of the same band
wavelength. This is done in ImageJ as described above.

Calibration:
The normalized VIS+NIR band images of the lunar feature of interest
are then calibrated by multiplying each band image by its
corresponding correction coefficient found in the relabbdr.tab file
previously discussed.
This completes the calibration of the VIS+NIR band images of the
target feature of interest against the Apollo 16 site and Apollo 16 soil
sample 62231.
Because the Selene 2B2 calibration does not involve geocorrection,
however, it is possible that re-calibrated images using this method
might have some residual error.
Therefore Method 2 outlined below is provided for comparison
purposes. Method 2 is based on Mauna Kea 2.2 meter telescope 120
color spectra calibration and has the advantage of more nearly
eliminating the distance between the calibration site and the target site
under investigation. Calibration data obtained with the Mauna Kea 2.2
meter telescope and McCord circular variable filter (CVF) NIR
Photometer is available from the PDS Geosciences Node as described
below.
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The results of this calibration are shown in the two figures below.
Block spectra were measured using ImageJ v 1.43J and spectral maps
were made in Octave.

Block Spectra, Coperncius Peak 3, Apollo 16 and soil #62231
calibration
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Spectral Maps, Copernicus Peak 3, Apollo 16 and soil #62231
calibration

Method 2: Using Mauna Kea 2.2 meter telescope 120 color
spectra for calibration

Mauna Kea 2.2 meter telescope 120 color spectra are availabe for a
large number of lunar featrures and have been pre-calibrated to the
Apollo 16 soil sample 62231. Since they are in hemispheric
reflectance, each band must be multiplied by a bidirectional reflectance
correction coefficient. Both the Mauna Kea 2.2 meter telescope 120
color spectra and the bidirectional reflectance correction file can be
downloaded from:
http://pds-geosciences.wustl.edu/missions/lunarspec/
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The name of the bidirectional reflectance correction file is:
CORRBDR.TAB

By referring to the index which is included in the Mauna Kea 2.2 meter
120 color spectra download, one of the Mauna Kea 2.2 meter telescope
spectral data files closest to the target feature of interest is chosen and
reflectance values are multiplied by the bidirectional reflectance
constant for each of the Selene VIS+NIRwavelengths of the target
feature VIS and NIR datasets that were downloaded from the Selene
Archive.
The target feature VIS+NIR spectra are normalized by selecting the
same boxed pixel area for each of the band images and obtaining an
average DN value for the boxed area using the histogram function in
ImageJ as was described above. The boxed area should be near, but not
identical to the longitude and latitude of the Mauna Kea 2.2 meter
telescope calibration file to be used. Each VIS+NIR band is then
divided by its histogram box average DN value. This serves to
normalize the nine image bands. This is done as previously described,
using the math function in ImageJ within an imported image sequence
of the nine spectral band images in 32 bit tiff format.

Normalization Area for Copernicus Peak 3 is boxed
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Finally, the normalized bands are multiplied by the bidirectional
reflectance corrected Mauna Kea 2.2 meter telescope spectral values
for the adjacent calibration site. Mauna Kea 2.2 meter telescope data
begins at about 0.62 microns, so it is not possible to calibrate the 0.415
micron Selene VIS image band. This is not very important since only
the 0.75 to 1.55 nm bands are useful in evaluating the absorption
trough near 1000 nm which is essential to mineral identification.
The disadvantage of Method 2 is that it sacrifices the 0.415 band
calibration but its advantage is that the calibration and target sites will
be much closer to each other than the target site would be to the Apollo
16 site used in Method 1.
Results of the calibration using Method 2 are shown in the block
spectra and spectral map figures below.

Copernicus Peak 3 target area (181,34) boxed
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Copernicus Peak 3, Mauna Kea CVF file HC1220 calibration

Copernicus Peak 3, Mauna Kea CVF HC1220 calibration.
Spectral Maps
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OMAT map (optical maturity map) Bright: 0.3, Dark: 0.1
Prepared from Mauna Kea CVF calibration.

Other Calibration Methods
For geographic areas where the Clementine UVVIS+NIR data do not
show the effects of thermal sensor instability in the NIR, it is possible
to use the Clementine imagery to calibrate Selene imagery of the same
general terrain. This is done procedurally much like the Mauna Kea 2.2
m telescope with CVF example above, except that the Mauna Kea
calibration file would be replaced by calibrated Clementine
UVVIS+NIR spectra normalized to the 0.75 micron image. After
normalizing the selene imagery using a selected pixel block
corresponding to the Clementine geography, the calibrated Clementine
spectral data for each band would be used as a multiplier for the
corresponding Selene band. It is, naturally necessary to interpolate
some values such as the 1.049 micron and 1.548 micron values and a
simple spline interpolation is useful for this purpose. We achieved a
successful calibration of gamma Reiner using this method which was
chosen because the Apollo 16 site did not normalize the Selene 0.749
band well and a Mauna Kea 2.2 m CVF data file was not available for
the general area of gamma Reiner.
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Results:

Evaluation of Mineral Content via characteristics of the iron
absorption trough near 1 micron have been discussed in detail in
prior Selenology Today articles including:

Evans, R. Analysis of Lunar Spectra and Multiband Images (2007)
Selenology Today Vol. 7. pp. 1-46.

which can be downloaded here: http://digilander.libero.it/glrgroup/
journal.htm

To summarize, calibrated Selene spectral band DN values obtained
using Method 1 or Method 2 above, for a boxed pixel area centered on
the target site of interest are obtained from 0.75 to 1.55 microns using
the described techniques in ImageJ. The DN values of all bands are
divided by the DN value of the 0.75 micron band, which serves to
normalize the spectra. The normalized spectra are plotted on a relative
reflectance vs wavelength plot and a line through (0.75, 1) and (1.55, y)
is taken tangent to the spectral curve, where y is the relative reflectance
of the normalized 1.55 micron band for the target feature. Next the
spectral curve is divided by the tangent line. This is achieved for each
wavelength band by dividing the relative normalized reflectance for
that band by

[(the band wavelength in microns * slope of the tangent line) + y-
intercept of the tangent line)].

The plot of the resulting curve vs the band wavelength is the continuum
divided spectrum and is extremely useful in evaluating the iron
absorption trough near 1 micron. This plot has the characteristic that
the relative reflectance of the 0.75 micron and the 1.55 micron band
will be 1.0. The band center of a trough between these wavelengths and
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the percent depth of the trough are significant in assessment of mineral
content as explained in the referenced paper in more detail.

Creation and interpretation of Spectral maps using VIS+NIR
spectra is explained in:

Evans R, Woehler C, and Lena R: Spectral mapping using Clementine
UV-Visible-NIR Data Sets: Applications to Lunar Geologic Studies.
(2009) Selenology Today, Vol. 14 pp. 1-70.

which can be downloaded here: http://digilander.libero.it/glrgroup/
journal.htm

Comparison of Mauna Kea 2.2 meter telescope based and Apollo
16 site based calibrations
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Selene VIS+NIR spectra calibrated using Mauna Kea 2.2 meter
telescope 120 color spectra corrected to bidirectional reflectance gave
good results when applied to central peak 3 of Copernicus. The
continuum divided spectra of the absorption trough near 1 micron
appear to be less noisy than prior results I have obtained using
Clementine UVVIS+NIR spectra with the standard Clementine USGS
calibration based on the Apollo 16 site and Apollo 16 soil sample
62231. Results for peak 3 of Copernicus in this study are consistent
with a significant olivine composition.

Amateur astronomers interested in lunar geology can use this method
to obtain spectra and spectral maps of geologic lunar features of
interest using the present 2B2 calibration of Selene multispectral
imager band images. Two methods by which this 2B2 calibrated data
set can be re-calibrated for evaluating the key iron absorption trough
near 1 micron are discussed. They each have advantages and
disadvantages. Use of Method 1 based on the Apollo 16 site and
Apollo 16 soil sample 62231 has the disadvantage that target areas of
interest will likely be geographically from the calibration site, but
calibration of the 0.415 micron band is achieved. Use of Method 2
based on Mauna Kea 2.2 meter telescope 120 color spectral data pre-
calibrated to the Apollo 16 soil sample 62231 has the advantage that its
large number of geographic calibration sites means that a target area of
interest is likely to be relatively close to a calibration site, at least as
compared to a calibration using the Apollo 16 site such as Method 1.
However, Mauna Kea 2.2 meter telescope 120 color spectra data cannot
be used to obtain a calibration of the 0.415 micron band image.

This paper is limited to block spectra and spectral mapping of
Copernicus central peak 3 based on either Apollo 16 and soil # 62231
or Mauna Kea 2.2 meter telescope 120 color spectrum calibration of the
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Selene 2B2 VIS+NIR band images. Comparison of the block spectra
and maps derived for these two calibration methods are present for
comparison purposes. For the most part the block spectra are quite
similar, although some variation is present for the site with pixel
coordinates of approximately (35,139), i.e. the purple block spectra
curve, which may reflect sampling error for this particular site.
Comparison of the spectral maps also shows that they are quite similar.

> 12. Conclusion

This manual is intended as an introductory guide to GLR activity in
lunar mineral studies and will evolve with time. Hopefully it will serve
as the basis of ongoing discussion and learning for GLR members.
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Appendix 1: Octave Code

Program Code for ClementineMaps.m:

% Algorithm to Extract bcw, depth and fwhm from Clementine 750 nm thru
1500 nm imagery

% load Clementine txt images from c:\Octave\ClemArchimedes 750nm to
1500 nm and assign % to A1 thru A7

A1 = dlmread ("750.txt");

A2 = dlmread ("900.txt");

A3 = dlmread ("950.txt");

A4 = dlmread ("1000.txt");

A5 = dlmread ("1100.txt");

A6 = dlmread ("1250.txt");

A7 = dlmread ("1500.txt");

% Create a 7 dimensional matrix D whose sheets are A1 through A7

D( :, :, 1) = A1;

D(:, :, 2) = A2;

D(:, :, 3) = A3;

D(:, :, 4) = A4;

D(:, :, 5) = A5;

D(:, :, 6) = A6;

D(:, :, 7) = A7;

% Create a 7 dimensional matrix E whose sheets are all A1

E(:, :, 1) = A1;
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E(:, :, 2) = A1;

E(:, :, 3) = A1;

E(:, :, 4) = A1;

E(:, :, 5) = A1;

E(:, :, 6) = A1;

E(:, :, 7) = A1;

[nr,nc] = size(A1);

% Normalize all Selene image bands to 750 nm band image

N = D./E;

%Start of Main Algorithm

r = 0;

c = 1;

% *************************************************************

for d = 1:nr*nc;

r = r + 1;

if r == nr + 1;

r = 1;

c = c + 1;

endif
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if c == nc + 1;

c = 1;

endif

% Calculate Continuum line for first pixel

slope = (N(r,c,7) - 1)/0.750;

intercept = -1 * ((slope * .750) -1);

% Continuum divided spectra

x1 = 0.750*slope + intercept;

x2 = 0.900*slope + intercept;

x3 = 0.950*slope + intercept;

x4 = 1.0*slope + intercept;

x5 = 1.1*slope + intercept;

x6 = 1.25*slope + intercept;

x7 = 1.5*slope + intercept;

M(r,c,1) = N(r,c,1)/x1;

M(r,c,2) = N(r,c,2)/x2;

M(r,c,3) = N(r,c,3)/x3;

M(r,c,4) = N(r,c,4)/x4;

M(r,c,5) = N(r,c,5)/x5;

M(r,c,6) = N(r,c,6)/x6;

M(r,c,7) = N(r,c,7)/x7;
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% apply cubic spline for continuum divided spectral data

H = [.750 .90 .950 1.0 1.1 1.25 1.5];

I = [M(r,c,1) M(r,c,2) M(r,c,3) M(r,c,4) M(r,c,5) M(r,c,6) M(r,c,7)];

% interpolate spline using Akima Interpolation at approx. 1 nm
intervals

xi = [linspace(0.75, 1.5,750)];

ysi = akima(H,I,xi);

% remove the % sign in the line below to enable the plot function

% plot(H,I,'o',xi,ysi,':')

% get bcw

[ymin,i] = min(ysi);

bcw = xi(i);

% get depth

depth = 1 - ysi(i);

% get FWHM uses Petr Mikulik m file for FWHM calculation

z = ones(1,750);
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aa = z.- ysi';

x = xi(1:750);

y = aa(1:750);

width = fwhm(x,y);

% build up data matrices

BCW(r,c) = bcw;

DEPTH(r,c) = depth;

FWHM(r,c) = width;

bcw;

depth;

width;

endfor

% ***************************************************************

% save map images

save ("-text","bandcenter","BCW");

save ("-text","banddepth","DEPTH");

save("-text","fwhm","FWHM");
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Octave Program Code for Applycoeff.m:

% matrix regression Clementine Imagery for elemental abundance of Fe,
Mg, Ca, Ti, Al, O

a = dlmread("banddepth.txt");

b = dlmread("bandcenter.txt");

c=dlmread("fwhm.txt");

d1=dlmread("1500.txt");

d2=dlmread("750.txt");

d = (d1 - d2)/1000;

aa=a.*a;

ab=a.*b;

ac=a.*c;

ad=a.*d;

bb=b.*b;

bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;

dd=d.*d;

% load matrix coefficients for Fe
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load("matrix001","A");

% multiply coefficients

a=A(1,1).*a;

b=A(1,2).*b;

c=A(1,3).*c;

d=A(1,4).*d;

aa=A(1,5).*aa;

ab=A(1,6).*ab;

ac=A(1,7).*ac;

ad=A(1,8).*ad;

bb=A(1,9).*bb;

bc=A(1,10).*bc;

bd=A(1,11).*bd;

cc=A(1,12).*cc;

cd=A(1,13).*cd;

dd=A(1,14).*dd;

% sum M images and add offset coefficient

M=a+b+c+d+aa+ab+ac+ad+bb+bc+bd+cc+cd+dd;
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Fe= M + A(1,15);

% save Fe matrix as matrix 002

filename = sprintf('matrix%03d.mat',2);

save(filename,'Fe')

% repeat for magnesium

a = dlmread("banddepth.txt");

b = dlmread("bandcenter.txt");

c=dlmread("fwhm.txt");

d1=dlmread("1500.txt");

d2=dlmread("750.txt");

d = (d1 - d2)/1000;

aa=a.*a;

ab=a.*b;

ac=a.*c;

ad=a.*d;

bb=b.*b;

bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;
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dd=d.*d;

% load matrix coefficients for Mg

load("matrix003","A");

% multiply coefficients

a=A(1,1).*a;

b=A(1,2).*b;

c=A(1,3).*c;

d=A(1,4).*d;

aa=A(1,5).*aa;

ab=A(1,6).*ab;

ac=A(1,7).*ac;

ad=A(1,8).*ad;

bb=A(1,9).*bb;

bc=A(1,10).*bc;

bd=A(1,11).*bd;

cc=A(1,12).*cc;

cd=A(1,13).*cd;

dd=A(1,14).*dd;
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% sum M images and add offset coefficient

M=a+b+c+d+aa+ab+ac+ad+bb+bc+bd+cc+cd+dd;

Mg= M + A(1,15);

% save Mg matrix as matrix 004

filename = sprintf('matrix%03d.mat',4);

save(filename,'Mg')

% repeat for calcium

a = dlmread("banddepth.txt");

b = dlmread("bandcenter.txt");

c=dlmread("fwhm.txt");

d1=dlmread("1500.txt");

d2=dlmread("750.txt");

d = (d1 - d2)/1000;

aa=a.*a;

ab=a.*b;

ac=a.*c;

ad=a.*d;
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bb=b.*b;

bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;

dd=d.*d;

% load matrix coefficients for Ca

load("matrix005","A");

% multiply coefficients

a=A(1,1).*a;

b=A(1,2).*b;

c=A(1,3).*c;

d=A(1,4).*d;

aa=A(1,5).*aa;

ab=A(1,6).*ab;

ac=A(1,7).*ac;

ad=A(1,8).*ad;

bb=A(1,9).*bb;
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bc=A(1,10).*bc;

bd=A(1,11).*bd;

cc=A(1,12).*cc;

cd=A(1,13).*cd;

dd=A(1,14).*dd;

% sum M images and add offset coefficient

M=a+b+c+d+aa+ab+ac+ad+bb+bc+bd+cc+cd+dd;

Ca= M + A(1,15);

% save Ca matrix as matrix 006

filename = sprintf('matrix%03d.mat',6);

save(filename,'Ca')

% repeat for Ti

a = dlmread("banddepth.txt");

b = dlmread("bandcenter.txt");

c=dlmread("fwhm.txt");

d1=dlmread("1500.txt");

d2=dlmread("750.txt");

d = (d1 - d2)/1000;



page 91

aa=a.*a;

ab=a.*b;

ac=a.*c;

ad=a.*d;

bb=b.*b;

bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;

dd=d.*d;

% load matrix coefficients for Ti

a = dlmread("banddepth.txt");

b = dlmread("bandcenter.txt");

c=dlmread("fwhm.txt");

d1=dlmread("1500.txt");

d2=dlmread("750.txt");

d = (d1 - d2)/1000;

aa=a.*a;

ab=a.*b;

ac=a.*c;
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ad=a.*d;

bb=b.*b;

bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;

dd=d.*d;

load("matrix007","A");

% multiply coefficients

a=A(1,1).*a;

b=A(1,2).*b;

c=A(1,3).*c;

d=A(1,4).*d;

aa=A(1,5).*aa;

ab=A(1,6).*ab;

ac=A(1,7).*ac;

ad=A(1,8).*ad;

bb=A(1,9).*bb;

bc=A(1,10).*bc;
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bd=A(1,11).*bd;

cc=A(1,12).*cc;

cd=A(1,13).*cd;

dd=A(1,14).*dd;

% sum M images and add offset coefficient

M=a+b+c+d+aa+ab+ac+ad+bb+bc+bd+cc+cd+dd;

Ti= M + A(1,15);

% save Ti matrix as matrix 008

filename = sprintf('matrix%03d.mat',8);

save(filename,'Ti')

% repeat for Al

a = dlmread("banddepth.txt");

b = dlmread("bandcenter.txt");

c=dlmread("fwhm.txt");

d1=dlmread("1500.txt");

d2=dlmread("750.txt");

d = (d1 - d2)/1000;
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aa=a.*a;

ab=a.*b;

ac=a.*c;

ad=a.*d;

bb=b.*b;

bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;

dd=d.*d;

% load matrix coefficients for Al

a = dlmread("banddepth.txt");

b = dlmread("bandcenter.txt");

c=dlmread("fwhm.txt");

d1=dlmread("1500.txt");

d2=dlmread("750.txt");

d = (d1 - d2)/1000;

aa=a.*a;

ab=a.*b;

ac=a.*c;
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ad=a.*d;

bb=b.*b;

bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;

dd=d.*d;

load("matrix009","A");

% multiply coefficients

a=A(1,1).*a;

b=A(1,2).*b;

c=A(1,3).*c;

d=A(1,4).*d;

aa=A(1,5).*aa;

ab=A(1,6).*ab;

ac=A(1,7).*ac;

ad=A(1,8).*ad;

bb=A(1,9).*bb;

bc=A(1,10).*bc;
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bd=A(1,11).*bd;

cc=A(1,12).*cc;

cd=A(1,13).*cd;

dd=A(1,14).*dd;

% sum M images and add offset coefficient

M=a+b+c+d+aa+ab+ac+ad+bb+bc+bd+cc+cd+dd;

Al= M + A(1,15);

% save Al matrix as matrix 010

filename = sprintf('matrix%03d.mat',10);

save(filename,'Al')

% repeat for O

a = dlmread("banddepth.txt");

b = dlmread("bandcenter.txt");

c=dlmread("fwhm.txt");

d1=dlmread("1500.txt");

d2=dlmread("750.txt");

d = (d1 - d2)/1000;
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aa=a.*a;

ab=a.*b;

ac=a.*c;

ad=a.*d;

bb=b.*b;

bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;

dd=d.*d;

% load matrix coefficients for O

a = dlmread("banddepth.txt");

b = dlmread("bandcenter.txt");

c=dlmread("fwhm.txt");

d1=dlmread("1500.txt");

d2=dlmread("750.txt");

d = (d1 - d2)/1000;

aa=a.*a;

ab=a.*b;

ac=a.*c;

ad=a.*d;
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bb=b.*b;

bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;

dd=d.*d;

load("matrix011","A");

% multiply coefficients

a=A(1,1).*a;

b=A(1,2).*b;

c=A(1,3).*c;

d=A(1,4).*d;

aa=A(1,5).*aa;

ab=A(1,6).*ab;

ac=A(1,7).*ac;

ad=A(1,8).*ad;

bb=A(1,9).*bb;

bc=A(1,10).*bc;

bd=A(1,11).*bd;
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cc=A(1,12).*cc;

cd=A(1,13).*cd;

dd=A(1,14).*dd;

% sum M images and add offset coefficient

M=a+b+c+d+aa+ab+ac+ad+bb+bc+bd+cc+cd+dd;

O= M + A(1,15);

% save O matrix as matrix 012

filename = sprintf('matrix%03d.mat',12);

save(filename,'O')
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Octave Code for newmatreg_v3.m

% matrix regression Clementine Imagery for elemental abundance of Iron

a = dlmread('banddepth.txt');

b = dlmread('bandcenter.txt');

c=dlmread('fwhm.txt');

d1=dlmread('1500.txt');

d2=dlmread('750.txt');

B=dlmread('LPFe.txt');

d=(d1 - d2)/1000;

% create row vectors

[nr,nc] = size(a);

length = nr* nc;

a = reshape(a,1,length);

b= reshape(b,1,length);

c=reshape(c,1,length);

d=reshape(d,1,length);

% exclude bad Clementine pixels

idx=find(a<0.2);

a=a(idx);

b=b(idx);

c=c(idx);
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d=d(idx);

aa=a.*a;

ab=a.*b;

ac=a.*c;

ad=a.*d;

bb=b.*b;

bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;

dd=d.*d;

B=reshape(B,1,length);

e=ones(1,length);

B=B(idx);

e=e(idx);

% create x matrix

x = [a;b;c;d;aa;ab;ac;ad;bb;bc;bd;cc;cd;dd;e];

% create coefficient matrix

A = mrdivide(B,x);

rmse = sqrt(mean((A*x-B).^2));

fprintf('RMSE(Fe) = %f\n',rmse);

filename = sprintf('matrix%03d.mat',1);

save(filename,'A')
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% repeat for magnesium

B=dlmread('LPMg.txt');

B=reshape(B,1,length);

e=ones(1,length);

B=B(idx);

e=e(idx);

% create coefficient matrix

A = mrdivide(B,x);

rmse = sqrt(mean((A*x-B).^2));

fprintf('RMSE(Mg) = %f\n',rmse);

filename = sprintf('matrix%03d.mat',3);

save(filename,'A')

% repeat for calcium

B=dlmread('LPCa.txt');

B=reshape(B,1,length);

e=ones(1,length);

B=B(idx);

e=e(idx);

% create coefficient matrix

A = mrdivide(B,x);

rmse = sqrt(mean((A*x-B).^2));
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fprintf('RMSE(Ca) = %f\n',rmse);

filename = sprintf('matrix%03d.mat',5);

save(filename,'A')

% repeat for Ti

B=dlmread('LPTi.txt');

B=reshape(B,1,length);

e=ones(1,length);

B=B(idx);

e=e(idx);

% create coefficient matrix

A = mrdivide(B,x);

rmse = sqrt(mean((A*x-B).^2));

fprintf('RMSE(Ti) = %f\n',rmse);

filename = sprintf('matrix%03d.mat',7);

save(filename,'A')

% repeat for Al

B=dlmread('LPAl.txt');

B=reshape(B,1,length);

e=ones(1,length);

B=B(idx);



page 104

e=e(idx);

% create coefficient matrix

A = mrdivide(B,x);

rmse = sqrt(mean((A*x-B).^2));

fprintf('RMSE(Al) = %f\n',rmse);

filename = sprintf('matrix%03d.mat',9);

save(filename,'A')

% repeat for O

B=dlmread('LPO.txt');

B=reshape(B,1,length);

e=ones(1,length);

B=B(idx);

e=e(idx);

% create coefficient matrix

A = mrdivide(B,x);

rmse = sqrt(mean((A*x-B).^2));

fprintf('RMSE(O) = %f\n',rmse);

filename = sprintf('matrix%03d.mat',11);

save(filename,'A')
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Petrologic Mapping: applycoeff_v2.m and
read_from_ternary_diagram.m

This specialty version of applycoeff.m uses three endmember data to
produce a petrographic map. The resulting petrographic map is
saved as a 24-bit colour TIFF file named "petrographic_map.tif", in
which the red, green, and blue channel represents the mare basalt,
Mg-rich rock, and FAN endmember, respectively. The sum of the
channels is always 255, as the endmember abundances always must sum
up to 1. For Reiner Gamma, we have mostly mare basalt, some Mg-rich
rock, and nearly no FAN; that's why the petrographic map looks red-
orange. Both m files must be in the same directory as the input
image files and matrix files.

applycoeff_v2.m

% matrix regression Clementine Imagery for elemental abundance of Fe,
Mg, Ca, Ti, Al, O

a = dlmread("banddepth.txt");

b = dlmread("bandcenter.txt");

c=dlmread("fwhm.txt");

d1=dlmread("1500.txt");

d2=dlmread("750.txt");

d = (d1 - d2)/1000;

aa=a.*a;

ab=a.*b;

ac=a.*c;

ad=a.*d;
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bb=b.*b;

bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;

dd=d.*d;

% load matrix coefficients for Fe

load("matrix001","A");

% multiply coefficients

a=A(1,1).*a;

b=A(1,2).*b;

c=A(1,3).*c;

d=A(1,4).*d;

aa=A(1,5).*aa;

ab=A(1,6).*ab;

ac=A(1,7).*ac;

ad=A(1,8).*ad;

bb=A(1,9).*bb;
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bc=A(1,10).*bc;

bd=A(1,11).*bd;

cc=A(1,12).*cc;

cd=A(1,13).*cd;

dd=A(1,14).*dd;

% sum M images and add offset coefficient

M=a+b+c+d+aa+ab+ac+ad+bb+bc+bd+cc+cd+dd;

Fe= M + A(1,15);

% save Fe matrix as matrix 002

filename = sprintf('matrix%03d.mat',2);

save(filename,'Fe')

% repeat for magnesium

a = dlmread("banddepth.txt");

b = dlmread("bandcenter.txt");

c=dlmread("fwhm.txt");

d1=dlmread("1500.txt");

d2=dlmread("750.txt");
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d = (d1 - d2)/1000;

aa=a.*a;

ab=a.*b;

ac=a.*c;

ad=a.*d;

bb=b.*b;

bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;

dd=d.*d;

% load matrix coefficients for Mg

load("matrix003","A");

% multiply coefficients

a=A(1,1).*a;

b=A(1,2).*b;

c=A(1,3).*c;

d=A(1,4).*d;
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aa=A(1,5).*aa;

ab=A(1,6).*ab;

ac=A(1,7).*ac;

ad=A(1,8).*ad;

bb=A(1,9).*bb;

bc=A(1,10).*bc;

bd=A(1,11).*bd;

cc=A(1,12).*cc;

cd=A(1,13).*cd;

dd=A(1,14).*dd;

% sum M images and add offset coefficient

M=a+b+c+d+aa+ab+ac+ad+bb+bc+bd+cc+cd+dd;

Mg= M + A(1,15);

% save Mg matrix as matrix 004

filename = sprintf('matrix%03d.mat',4);

save(filename,'Mg')

% repeat for calcium
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a = dlmread("banddepth.txt");

b = dlmread("bandcenter.txt");

c=dlmread("fwhm.txt");

d1=dlmread("1500.txt");

d2=dlmread("750.txt");

d = (d1 - d2)/1000;

aa=a.*a;

ab=a.*b;

ac=a.*c;

ad=a.*d;

bb=b.*b;

bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;

dd=d.*d;

% load matrix coefficients for Ca

load("matrix005","A");
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% multiply coefficients

a=A(1,1).*a;

b=A(1,2).*b;

c=A(1,3).*c;

d=A(1,4).*d;

aa=A(1,5).*aa;

ab=A(1,6).*ab;

ac=A(1,7).*ac;

ad=A(1,8).*ad;

bb=A(1,9).*bb;

bc=A(1,10).*bc;

bd=A(1,11).*bd;

cc=A(1,12).*cc;

cd=A(1,13).*cd;

dd=A(1,14).*dd;

% sum M images and add offset coefficient

M=a+b+c+d+aa+ab+ac+ad+bb+bc+bd+cc+cd+dd;

Ca= M + A(1,15);

% save Ca matrix as matrix 006
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filename = sprintf('matrix%03d.mat',6);

save(filename,'Ca')

% repeat for Ti

a = dlmread("banddepth.txt");

b = dlmread("bandcenter.txt");

c=dlmread("fwhm.txt");

d1=dlmread("1500.txt");

d2=dlmread("750.txt");

d = (d1 - d2)/1000;

aa=a.*a;

ab=a.*b;

ac=a.*c;

ad=a.*d;

bb=b.*b;

bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;

dd=d.*d;
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% load matrix coefficients for Ti

a = dlmread("banddepth.txt");

b = dlmread("bandcenter.txt");

c=dlmread("fwhm.txt");

d1=dlmread("1500.txt");

d2=dlmread("750.txt");

d = (d1 - d2)/1000;

aa=a.*a;

ab=a.*b;

ac=a.*c;

ad=a.*d;

bb=b.*b;

bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;

dd=d.*d;

load("matrix007","A");

% multiply coefficients
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a=A(1,1).*a;

b=A(1,2).*b;

c=A(1,3).*c;

d=A(1,4).*d;

aa=A(1,5).*aa;

ab=A(1,6).*ab;

ac=A(1,7).*ac;

ad=A(1,8).*ad;

bb=A(1,9).*bb;

bc=A(1,10).*bc;

bd=A(1,11).*bd;

cc=A(1,12).*cc;

cd=A(1,13).*cd;

dd=A(1,14).*dd;

% sum M images and add offset coefficient

M=a+b+c+d+aa+ab+ac+ad+bb+bc+bd+cc+cd+dd;

Ti= M + A(1,15);

% save Ti matrix as matrix 008
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filename = sprintf('matrix%03d.mat',8);

save(filename,'Ti')

% repeat for Al

a = dlmread("banddepth.txt");

b = dlmread("bandcenter.txt");

c=dlmread("fwhm.txt");

d1=dlmread("1500.txt");

d2=dlmread("750.txt");

d = (d1 - d2)/1000;

aa=a.*a;

ab=a.*b;

ac=a.*c;

ad=a.*d;

bb=b.*b;

bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;

dd=d.*d;
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% load matrix coefficients for Al

a = dlmread("banddepth.txt");

b = dlmread("bandcenter.txt");

c=dlmread("fwhm.txt");

d1=dlmread("1500.txt");

d2=dlmread("750.txt");

d = (d1 - d2)/1000;

aa=a.*a;

ab=a.*b;

ac=a.*c;

ad=a.*d;

bb=b.*b;

bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;

dd=d.*d;

load("matrix009","A");

% multiply coefficients
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a=A(1,1).*a;

b=A(1,2).*b;

c=A(1,3).*c;

d=A(1,4).*d;

aa=A(1,5).*aa;

ab=A(1,6).*ab;

ac=A(1,7).*ac;

ad=A(1,8).*ad;

bb=A(1,9).*bb;

bc=A(1,10).*bc;

bd=A(1,11).*bd;

cc=A(1,12).*cc;

cd=A(1,13).*cd;

dd=A(1,14).*dd;

% sum M images and add offset coefficient

M=a+b+c+d+aa+ab+ac+ad+bb+bc+bd+cc+cd+dd;

Al= M + A(1,15);

% save Al matrix as matrix 010

filename = sprintf('matrix%03d.mat',10);



page 118

save(filename,'Al')

% repeat for O

a = dlmread("banddepth.txt");

b = dlmread("bandcenter.txt");

c=dlmread("fwhm.txt");

d1=dlmread("1500.txt");

d2=dlmread("750.txt");

d = (d1 - d2)/1000;

aa=a.*a;

ab=a.*b;

ac=a.*c;

ad=a.*d;

bb=b.*b;

bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;

dd=d.*d;



page 119

% load matrix coefficients for O

a = dlmread("banddepth.txt");

b = dlmread("bandcenter.txt");

c=dlmread("fwhm.txt");

d1=dlmread("1500.txt");

d2=dlmread("750.txt");

d = (d1 - d2)/1000;

aa=a.*a;

ab=a.*b;

ac=a.*c;

ad=a.*d;

bb=b.*b;

bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;

dd=d.*d;

load("matrix011","A");

% multiply coefficients

a=A(1,1).*a;

b=A(1,2).*b;
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c=A(1,3).*c;

d=A(1,4).*d;

aa=A(1,5).*aa;

ab=A(1,6).*ab;

ac=A(1,7).*ac;

ad=A(1,8).*ad;

bb=A(1,9).*bb;

bc=A(1,10).*bc;

bd=A(1,11).*bd;

cc=A(1,12).*cc;

cd=A(1,13).*cd;

dd=A(1,14).*dd;

% sum M images and add offset coefficient

M=a+b+c+d+aa+ab+ac+ad+bb+bc+bd+cc+cd+dd;

O= M + A(1,15);

% save Fe matrix as matrix 012

filename = sprintf('matrix%03d.mat',12);
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save(filename,'O');

% compute petrographic map

fan_fe=0.0050;

fan_mg=0.0100;

mb_fe=0.1800;

mb_mg=0.0650;

mgs_fe=0.0400;

mgs_mg=0.1300;

f=read_from_ternary_diagram([fan_fe; fan_mg],[mb_fe; mb_mg],[mgs_fe;
mgs_mg],0.01.*Fe(:),0.01.*Mg(:));

[nr,nc]=size(Fe);

bas=reshape(f(2,:),nr,nc); % mare basalt

mgr=reshape(f(3,:),nr,nc); % Mg-rich rock

fan=reshape(f(1,:),nr,nc); % FAN

pm=zeros(nr,nc,3);

pm(:,:,1)=bas;

pm(:,:,2)=mgr;

pm(:,:,3)=fan;

imwrite(pm,'petrographic_map.tif');
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Program code for applycoeff_v3a.m which maps variations
in mare basalt composition:

% matrix regression Clementine Imagery for elemental abundance of Fe,
Mg, Ca, Ti, Al, O

a = dlmread("banddepth.txt");

b = dlmread("bandcenter.txt");

c=dlmread("fwhm.txt");

d1=dlmread("1500.txt");

d2=dlmread("750.txt");

d = (d1 - d2)/1000;

aa=a.*a;

ab=a.*b;

ac=a.*c;

ad=a.*d;

bb=b.*b;

bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;

dd=d.*d;
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% load matrix coefficients for Fe

load("matrix001","A");

% multiply coefficients

a=A(1,1).*a;

b=A(1,2).*b;

c=A(1,3).*c;

d=A(1,4).*d;

aa=A(1,5).*aa;

ab=A(1,6).*ab;

ac=A(1,7).*ac;

ad=A(1,8).*ad;

bb=A(1,9).*bb;

bc=A(1,10).*bc;

bd=A(1,11).*bd;

cc=A(1,12).*cc;

cd=A(1,13).*cd;

dd=A(1,14).*dd;
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% sum M images and add offset coefficient

M=a+b+c+d+aa+ab+ac+ad+bb+bc+bd+cc+cd+dd;

Fe= M + A(1,15);

% save Fe matrix as matrix 002

filename = sprintf('matrix%03d.mat',2);

save(filename,'Fe')

% repeat for magnesium

a = dlmread("banddepth.txt");

b = dlmread("bandcenter.txt");

c=dlmread("fwhm.txt");

d1=dlmread("1500.txt");

d2=dlmread("750.txt");

d = (d1 - d2)/1000;

aa=a.*a;

ab=a.*b;

ac=a.*c;

ad=a.*d;

bb=b.*b;
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bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;

dd=d.*d;

% load matrix coefficients for Mg

load("matrix003","A");

% multiply coefficients

a=A(1,1).*a;

b=A(1,2).*b;

c=A(1,3).*c;

d=A(1,4).*d;

aa=A(1,5).*aa;

ab=A(1,6).*ab;

ac=A(1,7).*ac;

ad=A(1,8).*ad;

bb=A(1,9).*bb;

bc=A(1,10).*bc;

bd=A(1,11).*bd;
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cc=A(1,12).*cc;

cd=A(1,13).*cd;

dd=A(1,14).*dd;

% sum M images and add offset coefficient

M=a+b+c+d+aa+ab+ac+ad+bb+bc+bd+cc+cd+dd;

Mg= M + A(1,15);

% save Mg matrix as matrix 004

filename = sprintf('matrix%03d.mat',4);

save(filename,'Mg')

% repeat for calcium

a = dlmread("banddepth.txt");

b = dlmread("bandcenter.txt");

c=dlmread("fwhm.txt");

d1=dlmread("1500.txt");

d2=dlmread("750.txt");

d = (d1 - d2)/1000;
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aa=a.*a;

ab=a.*b;

ac=a.*c;

ad=a.*d;

bb=b.*b;

bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;

dd=d.*d;

% load matrix coefficients for Ca

load("matrix005","A");

% multiply coefficients

a=A(1,1).*a;

b=A(1,2).*b;

c=A(1,3).*c;

d=A(1,4).*d;
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aa=A(1,5).*aa;

ab=A(1,6).*ab;

ac=A(1,7).*ac;

ad=A(1,8).*ad;

bb=A(1,9).*bb;

bc=A(1,10).*bc;

bd=A(1,11).*bd;

cc=A(1,12).*cc;

cd=A(1,13).*cd;

dd=A(1,14).*dd;

% sum M images and add offset coefficient

M=a+b+c+d+aa+ab+ac+ad+bb+bc+bd+cc+cd+dd;

Ca= M + A(1,15);

% save Ca matrix as matrix 006

filename = sprintf('matrix%03d.mat',6);

save(filename,'Ca')

% repeat for Ti
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a = dlmread("banddepth.txt");

b = dlmread("bandcenter.txt");

c=dlmread("fwhm.txt");

d1=dlmread("1500.txt");

d2=dlmread("750.txt");

d = (d1 - d2)/1000;

aa=a.*a;

ab=a.*b;

ac=a.*c;

ad=a.*d;

bb=b.*b;

bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;

dd=d.*d;

% load matrix coefficients for Ti

a = dlmread("banddepth.txt");

b = dlmread("bandcenter.txt");

c=dlmread("fwhm.txt");

d1=dlmread("1500.txt");
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d2=dlmread("750.txt");

d = (d1 - d2)/1000;

aa=a.*a;

ab=a.*b;

ac=a.*c;

ad=a.*d;

bb=b.*b;

bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;

dd=d.*d;

load("matrix007","A");

% multiply coefficients

a=A(1,1).*a;

b=A(1,2).*b;

c=A(1,3).*c;

d=A(1,4).*d;

aa=A(1,5).*aa;
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ab=A(1,6).*ab;

ac=A(1,7).*ac;

ad=A(1,8).*ad;

bb=A(1,9).*bb;

bc=A(1,10).*bc;

bd=A(1,11).*bd;

cc=A(1,12).*cc;

cd=A(1,13).*cd;

dd=A(1,14).*dd;

% sum M images and add offset coefficient

M=a+b+c+d+aa+ab+ac+ad+bb+bc+bd+cc+cd+dd;

Ti= M + A(1,15);

% save Ti matrix as matrix 008

filename = sprintf('matrix%03d.mat',8);

save(filename,'Ti')

% repeat for Al
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a = dlmread("banddepth.txt");

b = dlmread("bandcenter.txt");

c=dlmread("fwhm.txt");

d1=dlmread("1500.txt");

d2=dlmread("750.txt");

d = (d1 - d2)/1000;

aa=a.*a;

ab=a.*b;

ac=a.*c;

ad=a.*d;

bb=b.*b;

bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;

dd=d.*d;

% load matrix coefficients for Al

a = dlmread("banddepth.txt");

b = dlmread("bandcenter.txt");

c=dlmread("fwhm.txt");

d1=dlmread("1500.txt");

d2=dlmread("750.txt");
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d = (d1 - d2)/1000;

aa=a.*a;

ab=a.*b;

ac=a.*c;

ad=a.*d;

bb=b.*b;

bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;

dd=d.*d;

load("matrix009","A");

% multiply coefficients

a=A(1,1).*a;

b=A(1,2).*b;

c=A(1,3).*c;

d=A(1,4).*d;

aa=A(1,5).*aa;

ab=A(1,6).*ab;
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ac=A(1,7).*ac;

ad=A(1,8).*ad;

bb=A(1,9).*bb;

bc=A(1,10).*bc;

bd=A(1,11).*bd;

cc=A(1,12).*cc;

cd=A(1,13).*cd;

dd=A(1,14).*dd;

% sum M images and add offset coefficient

M=a+b+c+d+aa+ab+ac+ad+bb+bc+bd+cc+cd+dd;

Al= M + A(1,15);

% save Al matrix as matrix 010

filename = sprintf('matrix%03d.mat',10);

save(filename,'Al')

% repeat for O

a = dlmread("banddepth.txt");

b = dlmread("bandcenter.txt");
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c=dlmread("fwhm.txt");

d1=dlmread("1500.txt");

d2=dlmread("750.txt");

d = (d1 - d2)/1000;

aa=a.*a;

ab=a.*b;

ac=a.*c;

ad=a.*d;

bb=b.*b;

bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;

dd=d.*d;

% load matrix coefficients for O

a = dlmread("banddepth.txt");

b = dlmread("bandcenter.txt");

c=dlmread("fwhm.txt");

d1=dlmread("1500.txt");

d2=dlmread("750.txt");

d = (d1 - d2)/1000;
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aa=a.*a;

ab=a.*b;

ac=a.*c;

ad=a.*d;

bb=b.*b;

bc=b.*c;

bd=b.*d;

cc=c.*c;

cd=c.*d;

dd=d.*d;

load("matrix011","A");

% multiply coefficients

a=A(1,1).*a;

b=A(1,2).*b;

c=A(1,3).*c;

d=A(1,4).*d;

aa=A(1,5).*aa;

ab=A(1,6).*ab;

ac=A(1,7).*ac;

ad=A(1,8).*ad;
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bb=A(1,9).*bb;

bc=A(1,10).*bc;

bd=A(1,11).*bd;

cc=A(1,12).*cc;

cd=A(1,13).*cd;

dd=A(1,14).*dd;

% sum M images and add offset coefficient

M=a+b+c+d+aa+ab+ac+ad+bb+bc+bd+cc+cd+dd;

O= M + A(1,15);

% save Fe matrix as matrix 012

filename = sprintf('matrix%03d.mat',12);

save(filename,'O');

% compute petrographic map

hiti_ti=0.036;

hiti_al=0.063;

mb_ti=0.016;

mb_al=0.0925;
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aluminous_ti=0.00500;

aluminous_al=0.140;

f=read_from_ternary_diagram([hiti_ti; hiti_al],[mb_ti; mb_al],
[aluminous_ti; aluminous_al],0.01.*Ti(:),0.01.*Al(:));

[nr,nc]=size(Fe);

bas=reshape(f(2,:),nr,nc); % mare basalt

aluminous=reshape(f(3,:),nr,nc); % aluminous basalt

hiti=reshape(f(1,:),nr,nc); % hi titanium basalt

pm=zeros(nr,nc,3);

pm(:,:,1)=bas;

pm(:,:,2)=aluminous;

pm(:,:,3)=hiti;

imwrite(pm,'petrographic_map_basalt_3a.tif');
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read_from_ternary_diagram.m

function f=read_from_ternary_diagram(e1,e2,e3,x,y)

% e1, e2, e3: three endmembers (2x1 vectors)

a12=(e2(2)-e1(2))/(e2(1)-e1(1));

b12=e2(2)-a12*e2(1);

n12=zeros(2,1);

n12(1)=a12/sqrt(1.0+a12*a12);

n12(2)=-1.0/sqrt(1.0+a12*a12);

p12=-b12/sqrt(1.0+a12*a12);

d3=e3(1)*n12(1)+e3(2)*n12(2)-p12;

a23=(e3(2)-e2(2))/(e3(1)-e2(1));

b23=e3(2)-a23*e3(1);

n23=zeros(2,1);

n23(1)=a23/sqrt(1.0+a23*a23);

n23(2)=-1.0/sqrt(1.0+a23*a23);

p23=-b23/sqrt(1.0+a23*a23);

d1=e1(1)*n23(1)+e1(2)*n23(2)-p23;

a13=(e3(2)-e1(2))/(e3(1)-e1(1));

b13=e3(2)-a13*e3(1);

n13=zeros(2,1);

n13(1)=a13/sqrt(1.0+a13*a13);

n13(2)=-1.0/sqrt(1.0+a13*a13);
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p13=-b13/sqrt(1.0+a13*a13);

d2=e2(1)*n13(1)+e2(2)*n13(2)-p13;

% x, y: data points (nx1 vector)

n=length(x);

f=zeros(3,n);

for i=1:n

h3=x(i)*n12(1)+y(i)*n12(2)-p12;

f(3,i)=h3/d3;

h1=x(i)*n23(1)+y(i)*n23(2)-p23;

f(1,i)=h1/d1;

h2=x(i)*n13(1)+y(i)*n13(2)-p13;

f(2,i)=h2/d2;

end

% clipping to the interval [0,1]

for i=1:n

for j=1:3

if(f(j,i)<0.0)

f(j,i)=0.0;

end

if(f(j,i)>1.0)

f(j,i)=1.0;

end

end
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end

% normalisation to 1

for i=1:n

f(:,i)=f(:,i)/sum(f(:,i));

end
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Octave code for Akima.m is available here:

http://www.mathworks.in/matlabcentral/fileexchange/1814

Octave code for fwhm.m is available here:

http://octave.svn.sourceforge.net/viewvc/octave/trunk/octave-forge/
main/signal/inst/?pathrev=6041

Lunar Prospector global elemental abundance maps may be
downloaded in asc format from here:

http://www.mapaplanet.org/explorer/moon.html


